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Foreword
Thank you for purchasing the Dagstation DX2000 (DX). This
manual describes the basic functions and operating procedures
of the DX2000. To ensure correct use, please read this manual
thoroughly before operation. The following five manuals are
provided as DX2000 manuals.
Paper Manual

Manual Title Manual No.

DX2000 Operation Guide IM 04L42B01-02E
This manual. It is also provided in the CD.

Control of Pollution Caused by IM 04L41B01-91C
the Product
Gives a description of pollution control.

Electronic Manuals Provided on the Accompanying CD

Manual Title Manual No.

DX2000 Operation Guide IM 04L42B01-02E
This is the electronic version of the paper manual.

DX2000 User’s Manual IM 04L42B01-01E

Describes how to use the convenient functions of the
DX2000. Communication function is excluded.

DX1000/DX1000N/DX2000 IM 04L41B01-17E
Communication Interface User’s Manual
Describes how to use the communication functions using the
Ethernet and serial interfaces.

DAQSTANDARD User’s Manual  IM 04L41B01-61E
Describes how to use the accompanying software program,
DAQSTANDARD.

Notes

* The contents of this manual are subject to change without
prior notice as a result of continuing improvements to the
instrument’s performance and functions.

« Every effort has been made in the preparation of this manual
to ensure the accuracy of its contents. However, should you
have any questions or find any errors, please contact your
nearest YOKOGAWA dealer.

« Copying or reproducing all or any part of the contents of this
manual without YOKOGAWA's permission is strictly prohibited.

* The TCP/IP software of this product and the document
concerning the TCP/IP software have been developed/
created by YOKOGAWA based on the BSD Networking
Software, Release 1 that has been licensed from the Regents
of the University of California.

Trademarks

« All the brands or names of Yokogawa Electric’s products used
in this manual are either trademarks or registered trademarks
of Yokogawa Electric Corporation.

* Microsoft, MS-DOS, Windows, Windows NT, and Windows XP
are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

» Adobe, Acrobat, and PostScript are trademarks of Adobe
Systems Incorporated (Adobe Systems).

* CompactFlash and CF are trademarks of SanDisk Corporation.

« For purposes of this manual, the TM and ® symbols do not
accompany their respective trademark names or registered
trademark names.

* Company and product names that appear in this manual are
trademarks or registered trademarks of their respective holders.

Revisions
1st Edition: December 2005
2nd Edition: October 2006
3rd Edition: April 2007

3rd Edition: April 2007 (YK)
All Right Reserved, Copyright © 2005, Yokogawa Electric Corporation

Safety Precautions
The DX conforms to IEC safety class | (provided with terminal for
protective grounding), Installation Category Il, and EN61326-1 (EMC
standard), class A (use in a commercial, industrial, or business
environment).
The DX is a measurement category Il (CAT Il) instrument.

*

Measurement category Il (CAT Il)

Applies to measuring circuits connected to low voltage
installation, and electrical instruments supplied with power from
fixed equipment such as electric switchboards.

The general safety precautions described here must be observed
during all phases of operation. If the DX is used in a manner not
described in this manual, the protection provided by the DX may be
impaired. Yokogawa Electric Corporation assumes no liability for
the customer’s failure to comply with these requirements.

Use the DX as a measurement category Il (CAT Il) instrument. The
DX is designed for indoor use.

About This Manual

Please pass this manual to the end user. We also ask you to
store this manual in a safe place.

Read this manual thoroughly and have a clear understanding of
the product before operation.

This manual explains the functions of the product. It does not
guarantee that the product will suit a particular purpose of the
user.

Precautions Related to the Protection, Safety, and Alteration of

the Product
The following safety symbols are used on the product and in this
manual.

“Handle with care.” To avoid injury and damage to
the instrument, the operator must refer to the
explanation in the manual.

Protective ground terminal

Functional ground terminal (do not use this terminal
as a protective ground terminal.)

Alternating current

10 - >

Direct current

ON (power)

O OFF (power)

For the protection and safe use of the product and the system
in which this product is incorporated, be sure to follow the
instructions and precautions on safety that are stated in this
manual whenever you handle the product. Take special note
that if you handle the product in a manner that violates these
instructions, the protection functionality of the product may be
damaged or impaired. In such cases, YOKOGAWA does not
guarantee the quality, performance, function, and safety of
product.

When installing protection and/or safety circuits such as lightning
protection devices and equipment for the product and control
system or designing or installing separate protection and/or
safety circuits for fool-proof design and fail-safe design of the
processes and lines that use the product and the control system,
the user should implement these using additional devices and
equipment.

If you are replacing parts or consumable items of the product,
make sure to use parts specified by YOKOGAWA.

This product is not designed or manufactured to be used in
critical applications that directly affect or threaten human lives.
Such applications include nuclear power equipment, devices
using radioactivity, railway facilities, aviation equipment, air
navigation facilities, aviation facilities, and medical equipment.
If so used, it is the user’s responsibility to include in the system
additional equipment and devices that ensure personnel safety.
Do not modify this product.
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WARNING

Use the Correct Power Supply

Ensure that the source voltage matches the voltage of the power
supply before turning ON the power. In the case of a desktop
type, ensure that it is within the maximum rated voltage range of
the provided power cord before connecting the power cord.

Use the Correct Power Cord and Plug (Desktop Type)

To prevent electric shock or fire, be sure to use the power cord
supplied by YOKOGAWA. The main power plug must be plugged
into an outlet with a protective earth terminal. Do not disable this
protection by using an extension cord without protective earth
grounding.

Connect the Protective Grounding Terminal

Make sure to connect the protective grounding to prevent
electric shock before turning ON the power.

The power cord that comes with the desktop type is a three-
prong type power cord. Connect the power cord to a properly
grounded three-prong outlet.

Do Not Impair the Protective Grounding

Never cut off the internal or external protective grounding wire or
disconnect the wiring of the protective grounding terminal. Doing
so invalidates the protective functions of the instrument and
poses a potential shock hazard.

Do Not Operate with Defective Protective Grounding

Do not operate the instrument if the protective grounding might
be defective. Also, make sure to check them before operation.
Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable
liquids or vapors. Operation in such an environment constitutes
a safety hazard.

Prolonged use in a highly dense corrosive gas (H,S, SOx, etc.)
will cause a malfunction.

Do Not Remove Covers

The cover should be removed by YOKOGAWA's qualified
personnel only. Opening the cover is dangerous, because some
areas inside the instrument have high voltages.

Ground the Instrument before Making External Connections
Connect the protective grounding before connecting to the item
under measurement or control unit.

Damage to the Protection

Operating the instrument in a manner not described in this
manual may damage the instrument’s protection.

Exemption from Responsibility

YOKOGAWA makes no warranties regarding the product except
those stated in the WARRANTY that is provided separately.
YOKOGAWA assumes no liability to any party for any loss

or damage, direct or indirect, caused by the user or any
unpredictable defect of the product.

Handling Precautions of the Software

YOKOGAWA makes no warranties regarding the software
accompanying this product except those stated in the
WARRANTY that is provided separately.

Use the software on a single PC.

You must purchase another copy of the software, if you are to
use the software on another PC.

Copying the software for any purposes other than backup is
strictly prohibited.

Please store the original media containing the software in a safe
place.

Reverse engineering, such as decompiling of the software, is
strictly prohibited.

No portion of the software supplied by YOKOGAWA may be
transferred, exchanged, or sublet or leased for use by any third
party without prior permission by YOKOGAWA.

Handling Precautions of the DX

Use care when cleaning the DX, especially any plastic parts.
When cleaning, wipe using a dry soft cloth. Do not use
chemicals such as benzene or thinner, since these may cause
discoloring and deformation.

Keep electrically charged objects away from the signal terminals.
If you do, the DX may malfunction.

Do not apply volatile chemicals to the display, panel keys, etc.
Do not allow rubber and vinyl products to remain in contact

with the DX for long periods of time. If you do, the DX may
malfunction.

When not in use, make sure to turn OFF the power switch.

If there are any symptoms of trouble such as strange odors or
smoke coming from the DX, immediately turn OFF the power
switch and the power supply source. Then, contact your nearest
YOKOGAWA dealer.

Handling Precautions of the External Storage
Medium (CF Card)

Use caution in the handling of the external storage medium as it
is a delicate product.

Write operation to storage media may fail under high-
temperature or low-temperature environments. If you are using
the DX in a low-temperature environment (around 10 °C or
less), use the DX after the warm-up time (at least 30 minutes)
has elapsed. If you are using the DX under a high-temperature
environment (around 40 °C or more), it is recommended that the
external storage medium be inserted into the drive when saving
the data and be removed after the data storage operation is
finished.

Remove the storage medium from the drive when turning the DX
ON/OFF.

Touching the compact flash section when static electricity is built
up on the human body can lead to erroneous operation.

For the general handling precautions of the external storage
medium, see the instruction manual that came with the external
storage medium.

CAUTION

Do not eject the external storage medium while the access
indicator is illuminated. This can damage the data.

Do not access the storage medium in a place with vibrations or
shock. The storage medium or drive may malfunction.
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Checking the Contents of the Package
Unpack the box and check the contents before operating the
instrument. If some of the contents are not correct or missing or
if there is physical damage, contact the dealer from which you
purchased them.

DX2000

A name plate is located on the top panel of the DX (side panel on
models with the /H5[ ] option). Check that the model name and
suffix code given on the name plate match those on your order.

NO. (Instrument Number)
When contacting the dealer from which you purchased the
instrument, please give them the instrument number.

MODEL and SUFFIX Code

Model | Suffix Code | ®tor Description
DX2004 Dagstation DX2000 4ch, 125 ms (Fast sampling mode 25 ms)
DX2008 Dagstation DX2000 8ch, 125 ms (Fast sampling mode 25 ms)
DX2010 Dagstation DX2000 10ch, 1 s (Fast sampling mode 125 ms)
DX2020 Dagstation DX2000 20ch, 1 s (Fast sampling mode 125 ms)
DX2030 Dagstation DX2000 30ch, 1 s (Fast sampling mode 125 ms)
DX2040 Dagstation DX2000 40ch, 1 s (Fast sampling mode 125 ms)
DX2048 Dagstation DX2000 48ch, 1 s (Fast sampling mode 125 ms)
Internal -1 Standard memory
memory size  |-2 Large memory
External storage media | -4 With CF card
Language 2 English/German/French, deg F, and DST
(English version of DAQSTANDARD included)

Options A1 Alarm output 2 points |

A2 Alarm output 4 points ' "

A3 Alarm output 6 points |

A4 Alarm output 12 points ' '

IAS Alarm output 24 points ' 27 1!

/C2 RS-232 interface

/c3 RS-422A/485 interface *

/D5 VGA output

IF1 FAlL/status output > *®

IF2 FAIL + alarm output 22 points '+ 71"

H2 Clamped input terminal (detachable)

IH5[] Desktop type's

M1 Mathematical functions (including the report function) '

N1 Cu10, Cu25 RTD input/3 leg isolated RTD

IN2 3 leg isolated RTD®

IN3 Extended input type (PR40-20, Pt50, etc.)

/P1 24 VDC/AC power supply

R1 Remote control ''

[TPS4 24-VDC transmitter power supply (4 loops) "

TPS8 24-VDC transmitter power supply (8 loops)”® !!

/KB1 Easy Text Entry (with input terminal) ™

/KB2 Easy Text Entry (without input terminal)”®

/1USB1 USB interface

PM1 Pulse input (including remote control and mathematical

function) "
icc1 Calibration correction function
/MC1 External input function 2

1 IA1, /A2, IA3, IA4, IA5, and /F2 cannot be specified simultaneously.
*2 A5 and /F1 cannot be specified simultaneously.

*3 /C2 and /C3 cannot be specified simultaneously.

*4  [F1 and JF2 cannot be specified simultaneously.

5 [HS[]

Power cord UL, CSA st'd

Power cord VDE st'd

Power cord SAA st'd

Power cord BS st'd

: Power cord GB st'd

Null (fH5): Only for /P1 model (without power cord)

T&AMO

6 IN2 can be specified only for DX2010, DX2020, DX2030, DX2040 and DX2048.
*7  [TPS4, [TPS8, /A5 and /F2 cannot be specified simultaneously.
“8 I /TPS8 is specified, /A4 and /F1 cannot be specified simultaneously.
*9 /KB1 and /KB2 cannot be specified simultaneously.
*10 If /KB is specified, a remote control terminal (438227) is included.
11 If /PM1 is specified, /A5, /F2, /M1, and /R1 cannot be specified simultaneously.
The combination of /A2/F1 and the combination of /A4/TPS8 cannot be specified simultaneously.
12 /MC1 can be specified only for DX2010, DX2020, DX2030, DX2040 and DX2048.

Standard Accessories
The standard accessories below are supplied with the instrument.
Check that all contents are present and undamaged.

Y
8. One of these power cord types is supplied
according to the instrument’s suffix code

No. Name Part Number/ Qty. Notes
Model

1 Terminal screws E9655FX 5 M4 (spares)

2 Mounting brackets B9900BX 2 For panel mounting
Except for the /H5[ ]
models.

3 Door lock key B8706FX 2 —

4 DAQSTANDARD DXA120 1 CD. Software for

for DXAdvanced setting the DX and
displaying data.

5 DX2000 Operation  IM 04L42B01-02E 1 A4 size

Guide (this manual)
Control of Pollution  IM 04L41B01-91C 1
Caused by the
Product
6 User’s Manuals B87062Z 1 CD. Contains the
for the DX1000/ PDF file of the user’s
DX1000N/DX2000 manual.

7 CF card B9968NM 1 32 MB (The size and
model may change.)

8 Power cord A1006 WD 1 Supplied only for
models with the /H5D
option. Maximum
rated voltage: 125 V

A1009WD 1 Supplied only for
models with the /H5F
option. Maximum
rated voltage: 250 V

A1024WD 1 Supplied only for
models with the /H5R
option. Maximum
rated voltage: 250 V

A1054WD 1 Supplied only for
models with the /H5J
option. Maximum
rated voltage: 250 V

A1064WD 1 Supplied only for

models with the /H5H
option. Maximum rate
dvoltage: 250 V
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No. Name Part Number/  Qty. Notes Protection of Environment
Model
9 Remote control 438227 1 Remote controller.
terminal Supplied only for
models with the /KB1 10
option. With two AA
alkaline batteries and

labels for the remote
control terminal.

Control of Pollution Caused by the Product

For details, see the Control of Pollution Caused by the Product
(IM04L41B01-91C).

Optional Accessories (Sold Separately)

The following optional accessories are available for purchase
separately. If you make an order, make sure that all contents

are present and undamaged. For information about ordering
accessories, contact the dealer from which you purchased the DX.

Proper Disposal of This Product
This is an explanation of how to dispose of this product based
on Waste Electrical and Electronic Equipment (WEEE), Directive
2002/96/EC. This directive is only valid in the EU.
» Marking

This product complies with the WEEE Directive (2002/96/EC)

No. Name Model Minimum  Notes } .
aty marking requirement.
1 CF card 772091 1 128 MB The affixed product label (see below) indicates that you must not
772092 256 MB discard this electrical/electronic product in domestic household

772093
772094
2 CF card adapter 772090

1GB
3 Shunt resistor 415920 250 Q+0.1%
|

(for screw input terminal) =07 100 Q + 0.1%

1
1 512 MB waste.
1
1
1
1
415922 1 10Q+0.1%
1
1
1
2
1
1

+ Product Category

4 Shunt resistor 438920 250 Q+0.1% . . . o
(for clamped input 438921 100Q+01% With reference to the equipment types in the WEEE directive
terminal) 438922 100+0.1% Annex 1, this product is classified as a “Monitoring and Control
5 Mounting brackets B9900BX - instrumentation” product.
6 Door lock key B8706FX - Do not dispose in domestic household waste.
7 Remote control terminal 438227

Remote To return unwanted products, contact your local Yokogawa
controller. X
Europe B. V. office.

Style number, release number, and firmware

version number of the DX2000

Style number: This is the DX2000 hardware number that is
indicated on the name plate.

Release number: This is the DX2000 firmware number that is
indicated on the name plate. The number
corresponds to the integer part of the firmware
version number.

Example: If the firmware version number is 2.01, the release

number is 2.

Firmware version number: This number is displayed on the DX2000
system information screen. For the procedure,
see section 2.5, “Viewing the DX Information” in
the DX2000 User’s Manual (IM 04L42B01-01E).

— Release number
— Style number
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Conventions Used in This Manual

« This manual covers information regarding DX2000s that have a
suffix code for language “-2” (English).

» For details on how to set the language, see section 2.6,
“Changing the Language” in the DX2000 User’s Manual (IM
04L42B01-01E).

Unit
K: Denotes 1024. Example: 768 KB (file size)
k: Denotes 1000.

The following markings are used in this manual.

Improper handling or use can lead to injury to the user or damage
to the instrument. This symbol appears on the instrument to
indicate that the user must refer to the user’s manual for special
instructions. The same symbol appears in the corresponding place
in the user’s manual to identify those instructions. In the manual,
the symbol is used in conjunction with the word “WARNING” or

“CAUTION.”

Calls attention to actions or conditions that could cause serious or
fatal injury to the user, and precautions that can be taken to prevent
such occurrences.

CAUTION

Calls attentions to actions or conditions that could cause light
injury to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Note
Calls attention to information that is important for proper operation
of the instrument.

Indicates after this mark reference to related procedure or
explanation.

Bold characters
Indicates character strings that appear on the screen and the
operation keys.

Opening the Electronic Manuals

The accompanying CD contains PDF files of the manuals. When
you load the CD into the CD-ROM drive on your PC, a startup
screen appears. Click the manual title to open the respective
manual.

If the startup screen does not appear, double-click DX_manual in
My Computer, and open the manuals in the English directory.

Revision History
The contents of this manual corresponds to the DX with release
number 2 and style number 2.

Edition| DX Addition and change to functions

2 Version |German, French, and Chinese can be selected
1.11 |as display language.

Modbus client: 10 s, 20 s, and 30 s have been
added to the choices for the connection retry
interval.

24 VDC/AC power supply (/P1 option) have
been added.

Version |Tab key on the USB keyboard corresponds to
1.21  |arrow keys (/USB1 option).

Operations to request and release network
information are added.

Modbus client: Function to connect a server
with a unit number is changed.

Modbus client: Connection timeout value is
changed.

Modbus registers (floating point type for
communication input data) are added.

A data output format (Skip or OFF channel data
not output) is added.

Error messages 105, 221, and 222 are added.

Error messages 215, 218, 536 and 536 are
changed.

3 Release |Improvement to the operability on the historical
number |trend display.

2 Displaying the date in the grid time of the trend
display If the trend interval is set greater than
or equal to 1 h/div.

(Version
2.0x)

Improvement to the display group setup
operation.

Addition of the Upper and Lower settings to the
bar graph base position.

Relay action when the alarm ACK operation is
executed has been added to the alarm output
relay settings.

Ability to reset the computed value during
computation (/M1 and /PM1 options).

Changes to how the data files are named.

Sorting the files by the update date/time.

Storage method for constantly retaining the
most recent data files in the CF card (Media
FIFO).

Progress display when saving all data of the
internal memory.

Changing the initial display selection menu.

Improvement to the data save operation to the
USB flash memory (/USB1 option).

Retaining the state of the CapsLock and
NumLock keys on the USB keyboard (/USB1
option).

Function for automatically assigning MW100s
to the Modbus client.

Changing the default setting of the web server
function to “Use.”

Error messages, 129, 131, 132, 133, 134, 135,
136, 137, 513, 514, 515, and 516 have been
added.

Style |The waterproof construction of the DX front
number |panel complies with the NEMA4 standard
2
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Introduction to Functions

Measured Items

You can connect DC voltage, thermocouple, RTD, and ON/OFF input and measure
various values such as temperature and flow rate. The DX samples the input signals at
the scan interval to obtain the measured values. The fastest scan interval is 25 ms on
the DX2004 and DX2008 and 125 ms on the DX2010, DX2020, DX2030, DX2040, and
DX2048.

Up to four alarm conditions can be set for each measurement channel.

Data Storage Function

Display Function

Other Functions

DAQSTANDARD

There are two methods of recording measured data. One is to record the measured data
continuously, and the other is to record only when certain events occur such as alarms.
The measured data is recorded to the internal memory at a specified interval. The data in
the internal memory can be stored to a CF card automatically or manually. By connecting
to a network via the Ethernet interface, the measured data can also be automatically
transferred to an FTP server on a network.

Automatic data transfer to an FTP server

DX Il—; FTP server
[ é j

Ethernet

/\/ » Internal memo < @ CF card

Measurement input @

Measured data can be displayed as trends, numeric values, and bar graphs for each
group. In addition, the overview display can be used to display and monitor all channels
on a single screen.

Trend dlsplay Numeric (dlgltal) dlsplay Bar graph dlsplay Overview display

.‘
3

Wi e e wi WS s e dnes

Computation Function (option) Various types of computation can be performed by
assigning equations to computation channels.

FAIL/status output function (option) Outputs an alarm when the DX fails. The function
also monitors the DX status such as the remaining
amount of internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input
signal is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the
DX. The function can also be used to prohibit key
operation.

Communication function The Ethernet interface can be used to monitor the

DX using a Web browser and transmit e-mail when
an event occurs such as an alarm. In addition,
data of devices on the network can be loaded and
displayed using the Modbus protocol.

The accompanying software program, DAQSTANDARD, can be used to display the
measured data, convert the measured data format, and create DX setup data.

IM 04L42B01-02E



Introduction to Functions

DX System Configuration

The DX can be used to configure a system as shown below.
Referenced sections are of the DX2000 User’s Manual.
Referenced pages are of this manual.

PC

Ethernet
(Communication Interface User's Manual)

sl T

Temperature
4 | controller

{<

Recorder

7 Serial communication*
N Measurement (Communication Interface
T_ > input » User's Manual)
Sec. 3.3
Pulse input* » » CF card
P Sec. 3.10 | DX2000 | P Page 24

Transmitter power supply*
P> Page 61

Alarm output*
P Sec 3.5-3.8

FAlL/status output*

Terminology

USB flash memory
P Sec. 2.12

QD €=

UsB iort*

<— Keys

« Keyboard

“ P Sec. 2.11
Remote Terminal* 5
P Sec. 2.10

pSec. 2.9
« Remote input*
P Sec. 7.1
Monitor*
» P Page 62
——
*: Option

Memory sample

The operation of recording measured data.

Memory start

The operation of starting the memory sample.

Memory stop

The operation of stopping the memory sample.

Display data

The waveform data shown on the DX display. The data recorded at the sampling
interval for the displayed data.

Event data

Measured data recorded at a sampling interval separate from that of the display data.

IM 04L42B01-02E



Names of Parts

Front View
Key panel opened

LCD

Display various operation
displays such as the trend
display as well as setup
displays.

Front cover (Key panel)
Open the front cover by pulling
the cover while holding down
the tab at the center of the

‘ @@’ upper section of the cover.
\ /'}/\"

CAUTION

When closing the front cover, press
the front cover in until the tab at the
center of the upper section of the
cover is all the way up. If the front
cover is not closed completely, the

Power indicator —— ]
llluminates in red when the

power is turned ON. llluminates
in green while memory sample

is in progress.

Remote control sensor ——————
(/KB1 and /KB2 options)
Receives infrared light from the
remote control terminal.

Key panel cover water and dust proof capability may
Label (front of the key panel cover) Open the cover by pinching the be impaired.
Write arbitrary labels for your left tab and pulling forward.

convenience.
Front cover opened

USB port CF card slot
A USB port conforming to Rev.
1.1.

e [ 3 CF card access indicator
Power switch —— ] 5 5 4 5

a | CF card eject button
Used when ejecting the CF
S : card.

Door lock key (included)
Insert the pin in the left hole to lock.
Insert the pin in the right hole to unlock.

77
A
\ " /
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Names of Parts

Rear Panel

Serial interface port

(/C3 option)

A RS-422A/485 interface

connector.

Power supply terminal and
USB port (/lUSB1 option) protective earth terminal.
A USB port conforming to Rev. — Serial interface port
1.1. (/C2 option)
Ethernet port A RS-232 interface
A 10Base-T port. connector.
VGA output connector

(/D5 option)
A connector for an external
monitor.
& = = . .
- e ¢ Optional terminals (/A[ ], /F[ ],
© i - IR1, [TPS][ ], and /PM1 options)
} JJI Connect optional input/output
— . signal wires.
@ Oq [ © TE

¢ Input terminals (screw terminals
or clamped terminals (/H2 option))
Lm Connect input signal wires from the
d measured item.

Desktop Type (/H5[ ] Option)

Functional ground terminal

Handle / N\ — Power connector
7=\
‘\

o)
ﬂﬁ‘* % 9)]e

e
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DX2000 Workflow

When using the DX for the first time, carry out the following procedure.

Install the DX.

Installation P> Page 49 and subsequent pages

Connect input/output wires to the terminals and connectors on the
rear panel, and connect the power cord.
> Page 52 and subsequent pages

Turn the power ON.
r
owe P Page 13

Set the date/time, load the CF card, and so on.
Settings P Page 18 and 24

Wiring

Set measurement functions
Settings P Page 19 and subsequent page, page 28 and subsequent pages
Start the measurement. Perform operations such as switching the
screen and writing messages. Save the measured data.
P Page 39 and subsequent pages
Data Check and manage the measured data.
Use the accompanying software program, DAQSTANDARD, to display

the measured data and convert the measured data to Excel, Lotus, and
ASCII formats.

P Page 48

» DAQSTANDARD User's manual (IM 04L41B01-61E)
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Turning the Power ON/OFF

Turning the Power ON

A CAUTION

Before turning ON the power switch, check that

* The power cord/wires are connected correctly to the DX.

« The DX is connected to the correct power supply (see page 64).

If the input wires are connected in parallel with other devices, do not turn ON/OFF
the power switch of the DX or another device during operation. This can have
adverse effects on the measured values.

=

Open the operation cover.
2. Turn ON the power switch.
After performing a self-test for a few seconds, the operation screen appears.

3. Close the operation cover.

fo CAUTION

 If nothing is displayed when the power switch is turned ON, turn OFF the
power switch and check the points listed above one more time. After checking
the points, turn ON the power switch again. If the DX still does not work, it is
probably a malfunction. Contact your nearest YOKOGAWA dealer for repairs.

» If an error message is displayed on the screen, take measures according to the
description in chapter 11, “Troubleshooting” in the DX2000 User’s Manual.

* Turn ON the power switch, let the DX warm up for at least 30 minutes, and then
start the measurements.

Turning the Power OFF

fo CAUTION

Before turning OFF the power switch, check that the external storage medium is
not being accessed.

1. Open the operation cover.
2. Turn OFF the power switch.

3. Close the operation cover.

IM 04L42B01-02E
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Basic Operation

Panel Keys

o LCD

Key panel

DISP/ENTER key and four arrow
keys (up, down, left, and right)

Soft keys Switches the operation screen.
Selects the menu that is Selects and enters setup items.
displayed at the bottom of the

screen — DISP/ENTER key

0O O () : X Up arrow key

START/STOP key —{@s1)

Right arrow key
Memory start/stop
4. > Down arrow key
Left arrow key
ESC key _ Character/Number input keys
Cancels an operation Enters characters and numbers
USER key .
. MENU key Favorite key
E tes th d ) .
oX:fautizz © assigne Switches between the operation ~ Displays the operation screen (up to
P mode and setting mode eight screens) that are registered to
the key
FUNC key
* Displays the soft key menu in operation mode
» Hold down this key at least 3 s in the setting mode to switch from the setting
mode to the basic setting mode
Display

Shesy 1201 o1:53:07 oise N nin  (S)EH Status display section
1ninidiv 500 i Shows the display name, date/time, data
85.6 recording, alarm icon, etc.

¢ Data display section
Shows the measured data and the
functional setup display.

EkGEs B1:51

14 IM 04L42B01-02E



Basic Operation

Display on the Status Display Section

The following information is displayed in the status display section.

Memory sample status

Data type
DISP: Display data

EVENT: Event data
Memory sample

stopped

i
€D

=

Memory sample icon

Memory sample
in progress

EXT

GROUP 1 ALL
2085/09/22 18:57:53

G5 oisp LN 46nin

Display name or group name

For all channel display on the trend display,

“ALL” is displayed.

Date and time

Displayed in yellow while the time is being corrected.

When using the batch function

P1-process-BEBAA3 Batch name (shown alternately;
with the display name) ]
Date and time

If the “batch number-lot number” exceeds 20
characters, the “date and time” position is used to
display the “batch number-lot number.”

When using the login function
iln il Name of the user logged in

Display name
Date and time

When using the login and batch functions

i Name of the user logged in
Batch name (shown alternately:
with the display name)

Memory sample progress

Displays the progress using a green bar graph. The frame indicates the file save
interval (display data) or the data length (event data).

Error in internal memory.

Contact your nearest YOKOGAWA dealer for repairs.

Displays the remaining memory sample time for the left bar graph.

Alarm icon
Displayed when any alarm is activated.
Blinks when there are alarms that are

(Red) occurring but have not been acknowledged.

o) All alarms have been released after they
have occurred, but there are alarms that
(Green) have not been acknowledged.

Status icon
The status assigned to the status output
relay (/F1 option) is occurring.

m Keys are locked.

E E-mail transmission is enabled.

Computation icon (/M1 or /PM1 option)
White icon: Computation in progress

Yellow icon: Computation dropout occurred

' CF card icon
Date and time 1 @

[E! CF card is being accessed.

The green level display indicates the amount of _,ﬂ

CF card used. If Media FIFO* is not enabled and

the free space on the CF card falls below 10%,

the level indicator changes to red.

* See section 1.4, in the DX1000/DX1000N User’s
Manual. Media FIFO is a function available on
release number 2 or later.

5]
=1

Waiting.

Light blue icon: CF card in the slot is not
recognized. Remove and reset it.

CF card error.

Carry out the procedure below to reset the CF card icon to

normal.

* Replace the CF card with a normal one.

» Format the CF card on the DX (the data on the CF card
will be erased).

IM 04L42B01-02E
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Basic Operation

Run Modes

Mode Transition Diagram

Power ON

'

Operation mode Setting mode Basic setting mode

/ End menu > DISP/ENTER key

MENU key

Hold down
the FUNC key
for 3 seconds

Setting menu
display

Basic setting
menu display

MENU key sk
or ESC key tnd

DISP/ENTER DISP/ENTER
MENU ke
key or ESC kgy key 1 ESC key

1 it

ey T

| Setup display

Firmn

ke

‘T“'_I'

The DX has three modes.

Mode Description
Operation mode A mode for performing measurements.
Setting mode A mode in which input range, measurement method, and so on

are configured. Settings can be changed when memory sample is
in progress excluding some items.

Basic setting mode A mode used to set basic items such as the scan interval and
storage format of measured data. You cannot switch to this mode
when memory sample is in progress.

* For further details on the basic setting mode and setting mode, see page 67.

Carry out the steps given in the following pages. It will help you to understand the DX
operation.
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Basic Operation

Entering Values and Characters

The character/number input keys and DISP/ENTER key are used to set the date/time,
set the display span of the input range, set the tag, set the message string, enter the
password, etc.

DISP/ENTER key and four arrow
Character/Number input keys keys (up, down, left, and right)

—
>
@
o

=Y
VV\'E'JV

3
N\

ol|%
AR
=
A
815]5]5
I

+
%

7\
]
N\

Entering Values

When a window for entering a value appears, enter the value by performing the following
key operation.

* Left and right arrow keys: Selects the input position.

e Character/Number input keys: Enters a value.

The following soft key appears when it can be used.

e Space soft key: Enters a space.

Entering Character Strings

When a window for entering a character string appears, enter it by performing the
following key operation.

* Left and right arrow keys: Selects the input position.

¢ Character/Number input keys: Enters a character string.

The character to be entered is determined by the number of times the character type key
and the character/number input key is pressed. The character types that can be entered
vary depending on the item being set.

Del Bs Ins Asa’/l

Input status of the A/a/1 soft key

Input status of the Ins soft key

* Space soft key: Enters a space.

* Del soft key: Deletes the character at the cursor.
* Bs soft key: Deletes the character before the cursor.
* Ins soft key: Selects insert or overwrite.

Insert and overwrite mode toggles each time the Ins soft key is
pressed. The selected mode is shown on the right side of the soft
key display section.

* Alal1 soft key: Selects uppercase alphabet (A), lowercase alphabet (a), or value (1).
The character type that you can enter changes each time you press
the A/a/1 soft key. The selected character type is shown on the right
side of the soft key display section.

IM 04L42B01-02E
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Basic Operation

Changing the Date/Time

In this example, we will change the date to the 14th. After carrying out this step, reset the

time to the correct date/time.

1. Display the operation mode screen.

GROLP 1 = ,
2005/12/01 02:02:09 e 0157 NN 1nin

i v
. pOR0

I
0.0000
5
0.00060
]
08.680680
y
0.0000
y
0.0000
v
B.00060
v
8.8080

2. Press MENU once to display the setting menu.
GROLP 1 = .
oo ven pp:s R DS N 1onin (5]
Select Date/Time

Heas channel

Hath channel

Ext. channel

Display

Group set. Trip line
Hessage

Timer, Event action
Data save

Save/Load

HMenu custonize

vy v v v

v v v w

3. Press DISP/ENTER once to open the Time set window.

4. Setthe date to 14.
Select the input position:
Change the value:

Enter the input:
Cancel the setting:

Left and right arrow keys
Character/Number input keys
DISP/ENTER

Press ESC before pressing DISP/ENTER.

GROUP 1 r= :
ol ppecss R0 Ui I o (T)

Heas channel »

Hath channel

Ext. channel

Display

Group set, Trip line
Hessage

Timer, Event action
Data save

Save/Load

Menu custonize

|
= 51214 [R:p2:a%—————— Djsplay the Time set
b window

v v v w

5. Press ESC or MENU once to return to the operation mode screen.

Operation complete.

18
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Basic Operation

Operation Example in the Setting Mode: Changing the Input Range
Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.

DX2000
[

Type T
thermocouple Channel 2
<

1. Display the operation mode screen.

GROLP 1 = ,
2895/12/01 p2:02:29  ‘ree D157 I ldnin

i

. 0868
2 TN
8.6080

B T
o 0. 0868

y

B.000A

v
08.0660
v

=
=
=

2. Press MENU once to display the setting menu.
3. Press the down arrow key once to select Meas. Channel.
4. Press the right arrow key once.

GROLP 1 = )
s 12/en pe-octs R DI NN 10n  (T)

Date/Time |

Select the Rangs, Alarm

Hath channel Tag, Hemory sample, Alarn delay
Ext. channel
Hoving average
Display
! Color
Group set, Trip line
Zone. Scale. Bar graph
Hessage
. . Alarn mark, Color scale band
Timer, Event action

Calibration correction

Data save
Save/Load »
Henu custonize »

5. Press DISP/ENTER once.

GROUP 1 r= :
R e pcpon g vl N ein (S

Heas channel > Range. Alarn

First-CH Last-CH a1
r Range Select First-CH
Hode Range Span Lower  Span Lpper
Volt i -2. B@AR PR
r fAlarn
1 |0ff
2 | off
3 | oif
4 | 0ff
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Basic Operation

6. Press the Input soft key once.

GROLP 1 — —
sz s g D N nin (O

Heas channel > Range, Alarm
First-CH Last-CH ]

Hode Range Span Lower  Span lpper

Volt v -2. baan 2. ARAA

161

r Range ‘

& 1— Display the channel
setting window

r Alarn

1 [off
2 [off_
3 [off
4 Joff

E
7. Enter 002.

Select the digit:
Change the value:
Delete the value:
Cancel the setting:

Left and right arrow keys
Character/Number input keys

Space soft key

Press ESC before pressing DISP/ENTER.

8. Press DISP/ENTER once. The last channel is also set to 002.

9. Press the down arrow key once to move the cursor to Mode.

10. Press the TC soft key once. The cursor moves to Range, and the changed item is
displayed in yellow.

GROLP 1 = _
g5/ 12/al go-pa-1a  ped DIsP NN 10nin @

Heas channel > Range. Alarn
First-CH [682  Last-CH [[A

r Range
Hode Range Span Lower  Span Upper
'I$ R | 8.8 1768.8

Select TC

r Alarn

[off"
[0
[0fFf_
[off

R 8 B K E J [Hext 172
11. Press the Next soft key.

12. Press the T soft key once. The cursor moves to Span Lower.
13. Press the Input soft key once.

[N A

GROUP 1 ] .
R g1z e s I thor  (S) R
Heas channel > Range. Alarn

First-CH [682  Last-CH BB2

r Range

HMode Range Span Lover  Span Upper ‘

TC T -208.8 4A8. A
[i-200.8
¢ — Display the span lower
setting window
r Alarn

0ff
f

A
olo|o
2

i - purd
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Basic Operation

14. Enter 0.0 in the Span Lower box.

See step 7 for the procedure.
15. Press DISP/ENTER once. The cursor moves to Span Upper.
16. Enter 400.0 in the Span Upper box.

See step 7 for the procedure.

17. Press DISP/ENTER once. The changed items are entered, and the cursor returns
to First-CH. The changed items change from yellow to white.

GROUP 1 ] .
e paces R U HEEEEEmn  (©)
Heas channel > Range. Alarn

First-CH Last-CH 82
r Range
Hode Range Span Lower  Span Upper
TC T B.8 400.8
r Alarn
1 [o0ff
2 [off
3 [off
4 [0ff

18. Press ESC or MENU three times to return to the operation mode screen.

Operation complete.
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Basic Operation

Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval. Here, the scan interval on the DX2010

is changed to 2 s. The selectable scan intervals are different on the DX2004 and

DX2008, but the procedure is the same.

DX2000

Measures every 2 s

Type T
thermocouple  Channel 2

i

FEEO

1. Display the operation mode screen.

GROUP 1 = )
2005/12/81 82:39:89 Disp NN iinin ©
0

Inin/div

2. Press MENU once to display the setting menu.

GROLP 1 = _
ongs/12/81 go-pe-3s  “ped DISP NN 10nin

Heas channel

Math channel

Ext. channel

Display

Group set, Trip line
Hessage

Timer, Event action
Data save

Save/Load

Henu custonize

v v v v

vy v v v

3. Hold down FUNC for at least 3 s.

Basic Setting Hode

®

Setting menu

— Display the basic setting

A/D, Hemory
Burnout. RJC

Envi ronnent »
Report »
Time settings

Load settings. Initialize »
Connunication (Ethernet} »
Connunication (Serial) »

Status relay
End

mode menu

4. Press the down arrow key once to select A/D, Memory.

22
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Basic Operation

5. Press DISP/ENTER once.

A7D, Henory

Scan interval

Scan mode

Scan interval 1s

A/D integrate Auto

Henory
lrﬂata Kind Display

Press the down arrow key once to move the cursor to Scan interval.
7. Press the 2s soft key once. The cursor moves to A/D integrate, and the changed
item is displayed in yellow.
Cancel the setting: Press ESC before pressing DISP/ENTER.
8. Press DISP/ENTER once. The changed items are entered, and the cursor returns
to Scan mode.

o

A7D, Hemory

— Scan interval

Scan mode
Scan interval s e Set the scan interval to 2 s
A/D intesrate Aute
- Henory —
Data kind Display

9. Press ESC once to return to the basic setting mode menu.

10. Press the up arrow key twice to move the cursor to End.
11. Press DISP/ENTER once.

Basic Setting Hode

AR [ s Display the basic setting
flarn mode menu
A/D. Hemory
Burnout, RJC
Envi ronment
Report ¢ Display the confirmation
Tine settings Mo | [ Cancel window
Load settings, Initialize »
Communication (Ethernet> »
Connunication (Serial) »

Status relay

12. Press DISP/ENTER once. The settings are saved, and the DX returns to the

operation mode screen.
Discard the changes: Select No and press DISP/ENTER.
Do not end the basic setting mode: Select Cancel and press DISP/ENTER.

Operation complete.
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Basic Operation

Inserting/Removing a CF Card

Inserting a CF Card
1. Open the operation cover.

S 7'ZCF card

2. Insert the CF card into the slot.

GROUP 1

o=
oags/12/m mozaic1g e D1SP NN lhour

3. Close the operation cover.

Operation complete.

Removing a CF Card
<Operations in the Operation Mode>
1. Press FUNC once.
2. Press the Next soft key.

GROUP 1

o=
ongs/1o/8] a2-41-24  “ped DISP NN 1hour

Free
nessage

AlarnACK | Hessage

T

CAUTION

Forcing the CF card into the slot with
the upside down may cause damage.

Hanual
| sample |

With the label “This side up”
Qacing up

@ Displays the storage
N Y | mediaicon
0. 06600
A
@.0600
2
0.08600
[ v
0. 06600
— v
0.B86008
v
0.08600
y
0.08600
v
0.08600
y
0.06600
Y

0. 66609

@ Storage media icon
y
8.008a

2 |

5 I
.00ea

v

.0068

v

.0060

y
— Media eject

24
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Basic Operation

7.

Press the Media eject soft key once.

Press the CF soft key once. The message “Media can be removed safely”
appears.

Open the operation cover.

Press the CF card eject button. When you eject the CF card, the storage media
icon disappears.

Press the eject button in until it clicks.
The eject button stops at depressed
position. Pinch the left and right side
of the CF card and remove it.

7L Eject button

Close the operation cover.

Operation complete.

<Operation in the Basic Setting Mode>

1.

2.
3.
4.

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), select Load settings, Initialize > Media eject > CF, and
press DISP/ENTER.

Basic Setting Hode

Setting menu

Alarm
A/D. Hemory
Burnout. RJC
Enwironment »
Report »
Tine settings
Load settings
Comnunication {Ethernet} Initialize
Communication {Serial}
Status relay Select CF
End

The message “Media can be removed safely” appears.
Open the operation cover.
Press the CF card eject button. Remove the CF card.

Close the operation cover.

Operation complete.

Note

If you remove the CF card without carrying out the media eject procedure, the message “Media

was removed compulsorily” appears. Remove the CF card by carrying out the procedure above
to prevent damaging the data that is stored.

IM 04L42B01-02E
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Basic Operation

Saving the Setup Data

In this example, we will save the setup data to a file named “SF2” on the CF card.

1. Display the operation mode screen.

GROLP 1 r=
20051201 p2:41:10 ‘e DISP NN 1hour

=
=
=
=
=

10 y
0.060060

N

Press MENU once to display the setting menu.

Press the up arrow key twice to select Save/Load.

4. Press the right arrow key once and down arrow key three times.
s b0l w2z el VISP I tror  (S)

Date/Tine

w

Heas channel

4
Hath channel »
Ext. channel »

Display

Load display data
Group set. Trip line

Load event data
Hessage

Tiner, Event action lepr] i

Data saue Select Save settings

Henu custonize Fornat

4

Press DISP/ENTER once.
6. Enter “SF2” for the file name.
For the input procedure, see “Entering Values and Characters” on page 17.

GROUP 1 =1
SRR gl meraz-as A D1 NN o (D)
Save/Load > Save settings

Save settings
(File nane CF:/ [sFa

Space | Del Bs Ins | A/asl

7. Press DISP/ENTER once. The message “Data are being saved to media”
appears, and the setup data is saved.
8. Press ESC or MENU three times to return to the operation mode screen.

Operation complete.
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Basic Operation

Loading the Setup Data
In this example, we will load the setup data “SF2” from the CF card and update the DX

settings.

Here, only the setup data of the setting mode is loaded. To load the setup data of both
the setting mode and basic setting mode, press MENU, hold down FUNC for 3 s, select
Load settings, Initialize > Load settings, and press DISP/ENTER.

Display the operation mode screen.
Press MENU once to display the setting menu.

Press the up arrow key twice to select Save/Load.

AW DN A

Press the right arrow key once and down arrow key twice.

R ib/a -z A D1 I thor (D)
Date/Tine
Heas channel »
Math channel »
Ext. channel »
Display N

Load display data
Group set, Trip line

Load event data
Message

Tiner, Event action et e Select Load settings

Data save Save settings
Henu custonize Fornat

5. Press DISP/ENTER once to select the root directory (CF:/).
6. Press DISP/ENTER once to display the files in the root directory.
7. Select the file SF2.PDL using the up and down arrow keys.

GROLP 1 P , =
2085/12/8] 82:12:21 sy D (S8 -

Save/Load > Load settings

7 To move to a lower
File name Date / Tine directory, select the
SF2.POL 2085/12/81 82:43 directory, and press
DISP/ENTER.

To move to a higher
directory, press ESC.

Free space 31488 Kbytes

8. Press DISP/ENTER once. The message “File is being loaded from media”
appears, and the setup data is loaded. The DX automatically returns to the
operation mode screen.

Operation complete.
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Setting the Input Range and Alarm

Setup Example 1: Temperature Measurement Channel

DX2000
\ \
Type T
thermocouple Channel 1
- i
0.0 to 200.0°C 0 W)
Setup Item Description Number in the Figure
Channel Use channel 1. 1
Tag TI-001 2
Sensor Type T thermocouple 3
Input range 0.0 to 200.0°C 4

(1) Input Range
Press MENU (switch to the setting mode).
From the setting menu, select Meas Channel > Range, Alarm.

GROUP 1 =
bl gp-aqcs e D1 N tor (D)
Heas channel > Range, Alarm

First-CH [?1] Last-CH l@
r Range

Hode Range Sparll Lower  Span Upper 1
¢ f.8 Z?B.B
! 4
3
- Alarm
1 |off
2 [0ff
3 [off
4 |off
| It |
(2) Tag

From the setting menu, select Meas Channel > Tag, Memory sample, Alarm delay.

GROUP 1 ]
s raes e 01 NN 1o (T)
Heas channel > Tag, Hemory sample. Alarm delay

First-CH Last-CH [}

’7Tas h TI-g01 Py

‘ 2

{ Hemory sanple

On/0ff On
Alarn delay
{Time 18's

Operation complete.
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Setting the Input Range and Alarm

Setup Example 2: Flow Rate Measurement Channel and Alarm
DX2000

Flowmeter Channel 2

! 4-20mA "

Convert to 1-5 V with a shunt resistor

Setup Item Description Number in the Figure
Channel Use channel 2. 1
Tag F1-002 2
Input signal 1-5V 3
Input range 0.0 to 500.0 L/H 4
Alarm condition Output an alarm if the measured valueis 5

less than or equal to 120.0 L/H.
Output destination: Relay contact (103)

(1) Input Range and Alarm
Press MENU (switch to the setting mode).

From the setting menu, select Meas Channel > Range, Alarm.

GROUP 1 &
S poasy R D1 N hor  (S) )
Heas channel > Range, Alarm

First-CH E? Last-CH W
r Range

! 1
Hode Range Span Lover  Span Upper
1-5v 1-5v 1.800 5.008
Scale Lover Scale lpper Lnit
b 5.8 Lty
Low-cut
off
r Alarm
Relay
Tupe Value On/0ff  Nunmber
1 [On 128.8 I
2 | 0if
3 [off 5
4 | Off
(2) Tag
From the setting menu, select Meas Channel > Tag, Memory sample, Alarm delay.
GROUP 1 ]
oo earciy Gl VS NN thor  (5) o)
Meas channel > Tag, Memory sample. Alarn delay
First-CH Last-CH BB2

(Tas b F1-882 °

‘ 2

( Hemory sample

On/0ff On
Alarm delay
(Ti ne 18 s

Operation complete.
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Setting the Display

Setup Example 3: Assigning Channels to Groups

In this example, we will assign channels 1 and 2 to group 1.

Group 1
e P

GROUP 1 = .
2885/12/81 B2:49:25 DIsP NN 43nin
Inin/div

Channel 1

Channel 2

Setup Item Description Number in the Figure
Group Assign channel 1 and 2 to group 1. 1
(1) Group

Press MENU key (switch to the setting mode) and select Group set, Trip line.

GROUP 1 =
o1l pocesces R U NN 1or  [T) )
Group set. Trip line

Group nunber 1
Group set
On/0ff 0h o
Group nane GROUP 1 ®
CH set [@eT. B2 °
Trip line
1 off
2 off
3 0ff
4 off
1 2 3 4 5 [ Next 1/6

Operation complete.
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Setting the Display

Setup Example 4: Setting the Time Scale

Set the time per division of the trend waveform to 2 minutes.

gsgg;l'g,m 82:11:15 DisP I 36nin The sampling interval (the time

B corresponding to 1 dot) is 4 s
when the trend interval is 2 min.
30 dots x 4 s =2 min

\ll\lw\ll@\l”H\l\llw

30 dots/div

Setup Item Description Number in the Figure
Trend interval Set the time per division to 2 minutes. 1
The waveform is updated at every 4 s.

(1) Trend Interval
Press MENU (switch to the setting mode) and select Display > Trend/Save interval.

GROUP 1 ]
S egsog el VISP N tor (D) i
Display > Trend/Save interval

Trend / Save interval

Trend interval [/div] m 1
Save interval 1h

3is Inin 2nin Snin 1Bnin 15min  |Next 1/2

Operation complete.
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Setting the Data Storage

Setup Example 5: Continuously

In this example, we
and 2.

Record Measured Data and Automatically Save

will continuously record and save the measured data of channel 1

For the procedure to set the channel, see “Setting the Input Range and Alarm” on page

28.

For the procedure to set groups, see “Setting the Display” on page 30.

GROUP 1
20p5/12/8] B2:11:15

2nin/div

3 DIsp NI 36hin

*¢[<— Channel 1

L/ <— Channel 2

Automatically save to
the CF card periodically

<>

Setup Item Description Number in the Figure
Source channels Channel 1 (TI-001) and channel 2 (FI-002) 1
Data to be recorded Continuously record the display data from the start of the 2
measurement.
Data storage method  Automatically store every 24 hours. 3
Sampling interval 4 seconds. Set using the trend interval. 4
Sampling interval = (trend interval setting)/30 dots
Data file name Add “sample” to the file name. 5
Example: 000123 sampleYYMMDD_HHMMSS.DAD
1 T
Sequential number Date/Time of the first recorded data
Save Destination DATA-101 6

Directory

(1) Data to be Recorded
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode).
From the basic setting menu, select A/D, Memory.

Basic Setting Mode

A/D, Memory

Scan interval

Scan hode
Scan interval
A/D integrate

2s

Auto

Hemory —|
(Data kind Displaye I

32
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Setting the Data Storage

(2) Method of Storing to the CF Card (Auto Save ON/OFF)
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode).
From the basic setting menu, select Environment > Security, Media save, Batch.

Environment > Security, Hedia save, Batch

r Security E—
Key
Comnuni cation off

r Save —_—
fAuto save [T
Hedia FIFO off

r Batch
On/0ff off

0ff Login | Keylock

(3) Save the Settings
1. Press ESC to return to the basic setting menu.
2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.
3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

(4) Channels to Be Recorded
Press MENU (switch to the setting mode).

From the setting menu, select Meas Channel > Tag, Memory sample, Alarm delay.

GROLP 1 r=
e pory e D1 N trer (S o)

Meas channel > Tag. Hemory sample, Alarm delay

First-CH E?J Last-CH [ap2
Tag

-

’7Tas [Fl-s2 ‘

Hemory sanple
’70n/0ff

s

Alarn delay
’7Ti|ne

18 s
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Setting the Data Storage

(5) Interval for Saving the Data to the CF Card
From the setting menu, select Display > Trend/Save interval.

GROLP 1 =
i gizse R s N 1w (S) o)

Display > Trend/Save interval

Trend / Save interval

Trend interval [/div] | 2nin_! 4

Save interval 1day @ 3

30s Inin 2nin Smin 1Bmin 15min  |Next 1/2

(6) Data File Name
From the setting menu, select Data save > File header, Data file name.

GROLP 1 = -
SR ibm zcoscee 8 DIP NN hor  (S) n

Data save > File header, Data file name

File header
(Char-acters | ‘

Structure Date

Identified strings [sanple ° 5

( Data file name

Input Clear Copy

(7) Save Destination Directory (within the CF Card)
From the setting menu, select Data save > Save directory.

GROUP 1 =1 .
Ry pest e V1Y EEE tor  (S) )
Data save > Save directory

Save directory —|
’7 DATA-181 6

Directory name |

Input Clear Copy

Operation complete.
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Setting the Data Storage

Setup Example 6: Saving Measured Data at the Specified Time

Using the settings of Setup Example 5, we will save the measured data once at hour 0

every day.
Ev hour 0
‘ DX2000 ‘ (" 'z ‘ Automatically save
\ Y, to the CF card
di—u-‘l@
e
All settings other than those listed below are the same as Setup Example 5.
Setup Item Description Number in the Figure
Data storage time Save the data once at hour 0 every day. 7

Data storage method  Automatically save the measured dataat 8
the specified time.

(1) Setting the Time
Press MENU (switch to the setting mode).
From the setting menu, select Timer, Event action > Match time timer.

GROLP 1 o]
Soim poias R D1 N 1 (©) )
Timer, Event action > Match time timer
Timer nunber
Match time timer
Kind 7
Day
Hour :Hinute
Tiner action Repeat @
1 2 3 4

(2) Specifying the Data Storage
Press MENU (switch to the setting mode).
From the setting menu, select Timer, Event action > Event action.

GROUP 1 =
Shibm aisci e i I 1w (©) +31)

Timer, Event action > Event action

Logic box number
Event-fction

Event HatchT i meTimer C I 8
Match Tine Timer No. 1 C |
Action SaveDisplay .

! 2 3 4 5 6 Next 1/7

Operation complete.
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Customizing the Operation

Setup Example 7: Assigning the Screen Image Data Storage Function to the
USER key

In this example, we will set the DX so that the displayed screen image data can be saved
to the CF card by pressing the USER key. This function is called snapshot. The extension
of snapshot data files is .png.

USER key

Setup Item Description Number in the Figure
Event action Save the screen image data of the DX 1
using the USER key.

(1) Assigning an Action to the USER Key
Press MENU (switch to the setting mode) and select Timer, Event action > Event
action.

GROUP 1 = X o
28B5/12/81 02:18:28 DisP N 31nin 3] )

Timer, Event action > Event action

Logic box number (2]
Event-fiction

Event | Userkey

[ ]
-

fiction [ hot

1 2 3 4 5 6 Next 1/7

Operation complete.
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Customizing the Operation

Setup Example 8: Registering Frequently Used Screens to the Favorite Key
Up to eight operation mode screens that are frequently used can be registered to the

Favorite key. This enables you to monitor the operation by using only the Favorite key.
This feature is convenient when comparing data such as historical trends.

‘ ‘ Operation mode screens registered to the Favorite key
(example when three screens are registered)

Favorite key

e

o

[
===y

e
e

Favorite key Favorite key [ 1 66. 6

Favorite key

1. Display the screen to be registered.

GROUP 1 =
200571201 02:15:56 e 015 N 1day

2. Press FUNC once to display the FUNC key menu.
3. Press the Next soft key to display Favorite regist.

4. Press the Favorite regist soft key to display the registration list window.

Register the historical
trend to the Favorite key

IM 04L42B01-02E
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Customizing the Operation

5. Press the favorite number (1 to 8) soft key.

6. Press the Regist soft key.

Show the window for
entering the display name

7. Enter the screen name.

Select the digit: Left and right arrow keys

Enter characters: Character/Number input keys

Delete a character: Space soft key

Cancel the setting: Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 17.
8. Press DISP/ENTER once.

9. Repeat steps 1 to 8 to register up to eight screens.

Operation complete.
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Operation

Starting the Memory Sample
1. Press START once.

Memory sample starts.

(7 R

Recording data

Memory sample progress
DISP: Display data
EVENT: Event data
Saarib/mt poonzy ) 015P NN Sonin

Imin/div

START key P 5

Operation complete.

Stopping the Memory Sample
1. Press STOP once.

GROLP 1 = )
2605/12/81 B:09:49 Disp NN 20in  (S)EB
2nin/diy 0

/N

LH
A . Display the confirmation
| HereHathe S L Cancel window

19:22 19125 125 193 ] Grl

2. Select Mem+Math or Memory using the left and right arrow keys.

19018

Memory: Stops memory sample.
Mem+Math:  Stops memory sample and computation (option).

On models without the computation function (option), the confirmation message
“Do you want to stop data storage?” appears. Select Yes.

3. Press DISP/ENTER once.

i

Stop memory sampling.

Operation complete.
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Operation

Switching the Trend Display, Digital Display, and Bar Graph Display
1. Press DISP/ENTER once to show the display selection menu.

Left arrow key

[ Up arrow key
|

—
L)
DE - — /_I 21— Right arrow key
. — U@L} DISPIENTER key
= 4

|
L Down arrow key

N

Press the down arrow key to select TREND, DIGITAL, or BAR.

3. Press the right arrow key once to display the sub menu. To close the sub menu
that you opened, press the left arrow key.

4. Press the down arrow key to select the group.

GROLP 1 = : =
2005/12/01 B2:99:10 oise N 2in  (S) R )

DIGITAL » 2242 Select DIGITAL > GROUP 1

5. Press DISP/ENTER once to show the operation display of the selected group. To
close the menu without switching the display, press ESC.

Group number

GROLP 1 P= , = .
2095/12/8] 82:99:18 ois DN 2in () ER) 2]

218. 6

Press the down arrow key when the trend, digital, or bar graph is displayed to switch the
display in the order trend, digital, bar graph, trend, and so on. Press the up arrow key

to switch the display in reverse order. Press the right arrow key or the left arrow key to
switch the group.

Operation complete.

40 IM 04L42B01-02E



Operation

Writing the Message “START”
Registering the Word “START” in Message Number 1

1. Press MENU (switch to the setting mode) and select Message.

Press DISP/ENTER, the down arrow key once, and the Input soft key to show
the message registration window.

Hessage

Hessage No. 1-18

Characters
R ——
& — Show the message

registration window

=D 00 1 D Ul B LD D

Space Del Bs Ins Asa/l

Select the digit: Left and right arrow keys

Enter characters: Character/Number input keys

Delete a character:  Space soft key

Cancel the setting:  Press ESC before pressing DISP/IENTER.

For the input procedure, see “Entering Values and Characters” on page 17.

2. Press DISP/ENTER.

Hessage

Hessage Mo- 1-18

Characters
START

= D 00 —3 O U1 B €3 MO

=

3. Press ESC or MENU twice to return to the operation mode screen.

Operation complete.
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Operation

Writing Message Number 1 “START”
This operation can be carried out while memory sample is in progress. The message is

displayed on the trend display. Show the trend display first.

1. Press FUNC (display the FUNC key menu), press the Message soft key, and
press the 1 - 10 soft key.

GROUP 1 = .
2095/15/81 82:21:07 DIsp N 5énin

Inin/diy

o ————— Show the message
registration window

1 2 3 4 5 [ Next 1/2

1 soft key

2. Press the 1 soft key.

GROUP 1 = : =
2005/12/1 B2:21:44 o EEE e (S5

1nin/div

Shows the message

(time, message, and

message mark)

B2:21 START « Also recorded to the
T internal memory

Operation complete.
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Connecting to an Ethernet Network

Setup Example 9: Monitoring the DX on a PC Browser

In this example, we will connect the PC and the DX via hub in a one-to-one relationship

Ethernet

\ | DX2000

and display and monitor the DX screen on a browser on the PC.

DX
Setup Item Description Number in the Figure
IP address 192.168.1.101 1

Subnet mask

255.255.255.0

Web server function

Monitor from a Web browser on the PC
using operator page.

Access to the DX

Display the Web page and do not set
access privileges.

PC
Setup Item Description Number in the Figure
IP address 192.168.1.100 4

Subnet mask

255.255.255.0

(1) IP Address of the DX

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode).

From the basic setting menu, select Communication (Ethernet) > IP address, Host

settings.

Comnunication (Ethernet} > IP-address, Host settings

r [P-address
DHCP

Fixed [P-address
IP-address
Subnet mask
Default sateway

Not

192.168. _1.10le I 1

255.255.255. e
B B B B

—  Host settings

Host name

Domain hane

IM 04L42B01-02E
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Connecting to an Ethernet Network

(2) Enabling the Web Server Function on the DX
From the basic setting menu, select Communication (Ethernet) > Server.

Server —
FTP
Ueb Use o 2
SNTP Not
Hodbus Not
Use Not

(3) Display the DX Screen on the PC
From the basic setting menu, select Communication (Ethernet) > Web page.

Page type 2
Web page —

On/0ff [

Access control 0ff o 3

Command Not

Operator | Honitor

(4) Save the Settings
1. Press ESC to return to the basic setting menu.

2. Select End and press DISP/ENTER.

The window appears for you to confirm the saving of the settings.
3. Select Yes and press DISP/ENTER.

The DX returns to the operation mode screen.
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Connecting to an Ethernet Network

(5) Setting the PC
Set the IP address and subnet mask on the PC.

Internet Pratacal [TCP/IP) Prop

2l
General |
You can get IP zettings assigned automatically if pour network, supports
this capability. Othenwize, you need to ask your network administrator for
the appropriate P zettings.

" Obtain an IP address automatically
—* Use the following IP address:

IF address: 192 168 . 1 100 4
Subnet mask: I 255 285 . 255 . (g

Default gateway:

|

 [btain DNS server addiess autamatically
—* Usze the following DMS server addresses:

Prefered DMS server: | . . .

Alternate DMNS server: I ; ; ;
Advanced... |
] I Cancel |

(6) Checking the Connection

Send the command below from the PC and check that a correct response is returned.
Send

>ping 192.168.1.101

Response example
>Reply from 192.168.1.101: bytes=32 time<10ms TTL=255

(7) Displaying the DX Screen on the Browser
1. Start the browser on the PC.
2. Enter the following URL.
http://192.168.1.101/operator.htm
3. Check that the DX screen appears.

Pl
| rie e Feots Tk e "
|Gt - (- (2] (3] ] s b @i €))L T3
| Ak ] rerp-10.0 233 Hicpme s vem, e i

P Lot 15:25:4s [ 01 MR 1Tein

Operation complete.
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Connecting to an Ethernet Network

Setup Example 10: Automatically Transferring the Measured Data File to an FTP

Server

In this example, we will configure the DX so that the measured data is automatically
transferred to an FTP server on the network when the measured data is automatically
saved to the CF card. To automatically transfer the measured data files and report files,
the auto saving of the measured data must be configured in advance (see “Data storage
method” of the setup example 5).

This example assumes that the following network environment is used: DHCP enabled,
automatically obtain the DNS server information, and automatically register the DX host
name to the DNS server. Set the parameters according to your network environment.

Automatic data transfer to an FTP server

DX || FTPserver
\ \
N » :]<> Q CF card
Measurement input ;@

Ethernet

Setup Item Description Number in the Figure
Host name DAQSTATION1 1
Obtain the IP address Obtain automatically (DHCP) 2
Type of data to be transferred ~ Acquired measured data 3
FTP server Server name  abcdefg.co.jp 4

Port number 21
Login name FTPUSER1
Password al1234

(1) Host Settings and IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode).
From the basic setting menu, select Communication (Ethernet) > IP address, Host
settings.

r IP-address -]
DHCP | lUse | 2

DS accession Use o Automatically obtain the

Host-name register Use o

DNS server information.
Automatically register the
DX host name to the DNS
server.

r Host settinss
Host nane [DAGSTATIONT ————1

46
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Connecting to an Ethernet Network

(2) Data to Be Transferred to the FTP Server and the FTP Server
From the basic setting menu, select Communication (Ethernet) > FTP client.

Communication {Ethernet) > FTP elient

r FTP transfer file

DispiEvent data | O0n | 3
Report 0ff
Snapshot 0ff
r FIP connection
Primary
FTP server name [abcdefg ® 4
Port number 2le
Login name FTPUSERL °
Passuord al234 °
Account
PASY mode 0ff
Initial path
On 0ft

(3) Save the Settings
1. Press ESC to return to the basic setting menu.
2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.
3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

Operation complete.

Executing a File Transfer Test
1. Press FUNC once to display the FUNC key menu.

2. Press the FTP test soft key once.

GROUP 1 -
oBR5/12/81 15:47:25  byed D1SP NN 31nin
Inin/div I

Systen | Network |Favorite

3. Press the Primary soft key once. The messages “FTP test is being executed” and
“Execution is complete” are displayed. The test file (FTP_TEST.TXT) is sent to the
FTP server.

Operation complete.

Transferring the Data Files
When you start memory sample, the measured data file is transferred to the FTP server

when the data is saved to the CF card.

IM 04L42B01-02E
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Using DAQSTANDARD

Displaying the Measured Data on DAQSTANDARD

In this example, we will display the measured data using the accompanying software
program, DAQSTANDARD.
1. Insert the CF card containing the measured data file (.DAD or .DAE extension)
into the PC that has DAQSTANDARD installed.

2. Start DAQSTANDARD. The launcher is displayed.

| DAOSTANDARE

Launcher  Help

COMFIG

L Data viewer icon

3. Click the data viewer icon to start the data viewer.

@ er o [w] B3]
File View Help

e
| 140 Ayl [4e bl | Fd b (e BT

EZlr HEDEHE & ST

Ready [ 7

4. From the File menu, choose Open.
5. Inthe Open dialog box, select the desired file, and click Open.
The data is displayed.

(5 1 - [Dizplay File-Graph[051006_1510000.0AD]] = I Dlll
File Edit TimeAxis ‘-Axis View Window Conwvert Information Help -Iﬁllll
EH R Bleaa MEmmw g EEHE T EENEE e &7
|14 Ab| 4 Bl | R AT R B3
(GROUP 1
3004
ﬁ{ 2459
2004
& 2 %
5 o0
T ’
& oA
o
-100- I
16: 5‘2.00 16: 5;3.00 17, DID.DD 17, DI4.DD
(|2005/1 Q0| Abzolute Time [him:s]
e | >
— 4

Operation complete.
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Installation and Wiring

Installation Location
Install the DX indoors in a location that meets the following conditions.

Instrumentation Panel

The DX is designed to be installed in an instrumentation panel except for the desktop
type.

Well-Ventilated Location

To prevent overheating, install the DX in a well-ventilated location. For the panel cut
dimensions when arranging multiple DXs, see the page 51. Follow the panel cut
dimensions providing adequate space between instruments when other instruments
are arranged on the panel. For the desktop type, we recommend that a space of at
least 50 mm be provided around the left, right, and top panels of the DX.

Minimum Mechanical Vibrations

Choose an installation location with the minimum mechanical vibration. Installing the
DX in a location with large mechanical vibration not only causes adverse effects on
the mechanism but also may hinder normal recording.

Horizontal

Install the DX horizontally (However, the DX can be inclined up to 30 degrees
backwards for panel mounting).

Note

Condensation may occur if the DX is moved to another place where the ambient temperature is

higher, or if the temperature changes rapidly. In addition, measurement errors will result when
using thermocouples. If this happens, let the DX adjust to the new environment for at least one
hour before using it.

Do not install the DX in the following places.

Outdoors

In Direct Sunlight or Near Heat Sources

Install the DX in a place with small temperature fluctuations near room temperature
(23°C). Placing the DX in direct sunlight or near heat appliances can cause adverse
effects on the internal circuitry.

Where an Excessive Amount of Soot, Steam, Moisture, Dust, or
Corrosive Gases Are Present

Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX. Avoid
such locations.

Near Strong Magnetic Field Sources

Do not bring magnets or instruments that produce electromagnetic fields close to the
DX. Operating the DX in strong magnetic fields can cause errors in the measurements.
Where the Viewing of the Display Is Poor

The DX uses a TFT color LCD for the display. Therefore, viewing of the display from
an extreme angle is difficult. Install the DX so that the user can view the display from
the front.

IM 04L42B01-02E
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Installation and Wiring

Installation Procedure
Installation Procedure (Panel Mount Type)
Use a steel panel of thickness 2 mm to 26 mm.
1. Insert DX from the front of the panel.
2. Mount the DX to the panel using the mounting brackets that come with the
package as shown in the figure below.

» Use two brackets to support the top and bottom or the left and right sides of
the case (remove the seal that is covering the holes for the mounting brackets
beforehand).

» The proper torque for tightening the mounting screws is 0.7 to 0.9 Nem.

* Mount the DX to the rack according to the procedure below.

* First, attach the two mounting brackets and temporarily fasten the
attachment screws.

* Next, fix the DX in place by tightening the attachment screws with the
appropriate torque. When the DX is approximately perpendicular to the
panel as you fasten the screws, press the mounting bracket against the
case so that they are in contact with each other.

A CAUTION

» Tightening the screws too much can deform the case or damage the bracket.
» Be careful not to insert foreign objects or tools through the holes for the
mounting brackets in the case.

» Make sure the rubber gasket is affixed so that it does not become entangled
between the main unit and the panel. Affixing the gasket incorrectly will result in
failure to achieve sufficient dust and water proof performance.

/Correct /Incorrect: Gasket entangled
N Rubber gasket SO Rubber gasket
Bezel Bezel
Panel Panel

Panel Mounting Diagram
|Screw temporarily|

Panel

Mounting brackets

DX case
Attachment Panel Mounting Attachment screw
screw ™ brackets

Torque driver
(flat blade)

In contact with
each other

7
(The figure shows the case when the mounting brackets
are used on the top and bottom of the case.)

Note

To achieve sufficient dust and water proof performance, mount the DX in the middle of the
panel cut out.

50
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Installation and Wiring

External Dimensions and Panel Cut Dimensions
Panel Mount Type

Panel cut dimensions Unit: mm (approx. inch)

360 min Unless otherwise specified, tolerance

(14.17) is £3% (however, tolerance is 0.3 mm
when below 10 mm).
280.2 (11.03) =

ElS
—|<
Qi

281"

(11.06)

(When the /H2 or /PM1
option is installed)

226 (8.90) max. ya

v
295.2 (11.62) 27.3 221.6 (8.72) (Dimensions before attaching
288 (11.33) (1.07 168 (6.61 the mounting bracket)
180 (7.09) _2-26 < E
|(Allowahlepanelthickness) o, o
| . ]
& T g s
=) o~ (=) o~
s gg |5 g
3 woE] )
—_— - - a
|| 4.6 32.1 R
2.15) ~Ne - .
108 (2. (Dimensions after attaching
(4.25) the mounting bracket)

Desktop Type (/H5[ ] Option)
282.5 (11.12)

Unit: mm (approx. inch)

! Unless otherwise specified, tolerance
ﬁ% is £3% (however, tolerance is £0.3 mm

when below 10 mm).
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1®) )

253.3 (9.97) max. _—— (When the /H2 or /PM1

/ option is installed)
289.6 (11.40) 245.1 (9.65)
G
| /l N : L Si2
= 9 @
S| ® )
T|e T
~| = :.:
o o N
—— QS &
T 1811
| [ J =
o
e
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Installation and Wiring

Input Signal Wiring

AN

» To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

CAUTION

» If a strong tension is applied to the cable wired to the DX, the terminals of the DX
and/or the cable can be damaged. In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting
panel.

» To prevent fire, use signal wires having a temperature rating of 70°C or more.

» Do not apply a voltage exceeding the following value to the input terminals.
Otherwise, damage to the DX may result.

» Maximum input voltage: +60 VDC
* Maximum common mode voltage: 60 VDC (under measurement category |l
conditions)

» The DX is a product of installation category Il.
. _________________________________________________________________________________________________________________|

Precautions to Be Taken While Wiring

Take the following precautions when wring the input signal cables.

It is recommended that crimp-on lug with insulation sleeves (designed for

4-mm screws) be used when connecting the input/output signal wires to

the terminals. However, this does not apply clamped terminals (/H2).

Crimp-on lug with insulation sleeves (for 4 mm screws)

For clamped terminals (/H2), the following wire is recommended.

- Conductive cross-sectional area: 0.08 mm? to 1.5 mm? (AWG 28 to 16)

» Length of the stripped section of the wire: Approx. 7 mm

Take measures to prevent noise from entering the measurement circuit.

* Move the measurement circuit away from the power cable (power circuit) and ground
circuit.

 ltis desirable that the object being measured does not generate noise. However, if
this is unavoidable, isolate the measurement circuit from the object. Also, ground the
object being measured.

» Shielded wires should be used to minimize noise caused by electrostatic induction.
Connect the shield to the ground terminal of the DX as necessary (make sure you are
not grounding at two points).

» To minimize noise caused by electromagnetic induction, twist the measurement circuit
wires at short, equal intervals.

» Make sure to earth ground the protective ground terminal through minimum resistance
(less than 100 Q).

When using internal reference junction compensation on the thermocouple

input, take measures to stabilize the temperature at the input terminal.
» Always use the terminal cover.

» Do not use thick wires which may cause large heat dissipation (cross sectional area of
0.5 mm? or less recommended).

* Make sure that the ambient temperature remains reasonably stable. Large
temperature fluctuations can occur if a nearby fan turns ON or OFF.

Connecting the input wires in parallel with other devices can cause signal

degradation, affecting all connected devices. If you need to make a parallel

connection, then
* Turn the burnout detection function OFF.

» Ground the instruments to the same point.

» Do not turn ON or OFF another instrument during operation. This can have adverse
effects on the other instruments.

* RTDs cannot be wired in parallel.

52
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Installation and Wiring

Wiring Procedure
A terminal cover is screwed in place on the measuring input terminal block on the rear
panel. A label indicating the terminal arrangement is affixed to the cover.

1. Turn OFF the DX and remove the terminal cover.
2. Connect the signal wires to the terminals.

3. Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 N-m.

Note
Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for
clamped terminals (/H2). Fold over the conducting section of the wire, for example, to make
sure that the wire is securely connected to the clamped terminal.

Arrangement of the Input Terminals

PEDG | el
@ oY [ O e
& &
(@ oY [ © hoaS
& &
e oY [ © hoaS
Input terminal block 3 —-& ] { .{-—- Input terminal block 1
&
[ Y [ O o] ;
Input terminal block 4 _Jﬁ ] { 0+—- Input terminal block 2 8
[ o
=
nput Channel Assignments by Model 5
block | DX2004 DX2008 | DX2010 | DX2020 | DX2030 | DX2040 | DX2048 o
1 1-4 1-4 1-10 1-10 1-10 1-10 1-12 s
2 5-8 11-20 11-20 11-20 13-24 g:
3 21-30 21-30 25-36 (]
4 31-40 37-48
Screw terminal Clamp terminal
CH4 CH2
CH3 CH1 CH3 CH1
Input terminal block 1 of b 19 -
the DX2004 and DX2008 %ggg +A S @E -IB
B -B CH4 CH2

CH10 CH8 CH6 CH4 CH2
CH9 CH7 CH5 CH3 CH1 CH9 CH7 CH5 CH3 CH1

| ) ¢
it toinal ek 1o [ ORI

DX2030, and DX2040 BRSO DSBDDSE] | +ia Bl 1Bl |E
®®®®®®®®®® -IB CH10 CH8 CH6 CH4 CH2

CH12 CH10 CH8 CH6 CH4 CH2
H11 CH9 CH7 CHS5 CH3 CH1

Input terminal block 1 of @@@@@@@@®®®® b
the DX2048 DREERRRRER@R] A :
BB DDDDD @] -8 chizcrio cHs cHe cHe crz

CH11 CH9 CH7 CH5 CH3

CH1
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Installation and Wiring

Wiring Screw Terminals
DC voltage input/DI (ON/OFF) input

+
+
DC voltage input
RTD input
b
A \
[
B
B
b

—|||l—=

Lead wire resistance per wire of
10 Q or less. Make the resistance
of the three wires equal.

Wiring Clamped Terminals

TC input

Compensating leadwire

 d
]

(=<

DC current input

+
DC current input

Shunt resistor
Example: For 4 to 20 mA input, use a
shunt resistor of 250 Q * 0.1%.

Remove the terminal block
Hold both ends of the terminal
block and pull straight.

Note

RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally
across all channels. However, terminal b is also isolated on each channel on models with the
/N1 option (Cu10, Cu25 RTD input/3 leg isolated RTD) and /N2 option (3 leg isolated RTD).

Connect the terminal block

Hold both ends of the terminal block,
align with the connector on the DX
side, and push the terminal block into
the connector.

Connect the wires

Z Recommended
L 2 " length of stripped
wire: 7. mm

Recommended wire size
0.08 to 1.5 mm? (AWG 28 to 16)

Input signal wire

First, loosen the screw at the front using a
flat-blade screwdriver. Insert the input signal
wire into the slit on the right side of the

terminal block, and fasten the screw at the front.
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Installation and Wiring

Optional Terminal Wiring

A | WARNING |

» To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

* If a voltage of more than 30 VAC or 60 VDC is to be applied to the output terminals,
use ring-tongue crimp-on lugs with insulation sleeves on all terminals to prevent the
wires from slipping out when the screws become loose. Furthermore, use double-
insulated wires (dielectric strength of 2300 VAC or more) for the signal wires on which
a voltage of more than 30 VAC or 60 VDC is to be applied. For all other wires, use
basic insulated wires (dielectric strength of 1390 VAC). To prevent electric shock,
attach the terminal cover after wiring and make sure not to touch the terminals.

CAUTION

» Use the following circuit voltage for the connection to the alarm/FAIL/status
output terminal.
*  When the connection is to Mains Circuits (primary AC power source circuits):

150 V or less
*  When the connection is to circuits derived from Mains Circuits (secondary
circuits): 250 V or less

(Mains Circuits voltage is less than 300 V, and connection must be used by
isolation transformer.)

» To prevent fire, use signal wires having a temperature rating of 70«C or more.

» If a strong tension is applied to the cable wired to the DX, the terminals of the DX
and/or the cable can be damaged. In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting panel.

» Do not short the transmitter power supply output terminal or apply external
voltage to it. If you do, the DX may malfunction.

*  When using the transmitter power supply output terminal, do not use current that
exceeds the maximum output current (25 mADC). If you do, the DX may malfunction.

» Do not short the VIDEO OUT terminal or apply external voltage to it. If you do,
the DX may malfunction.
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Note

For remote control wiring, use shielded wires to reduce noise. Connect the shield to the
functional ground terminal or the ground terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed
for 4-mm screws) be used when connecting wires to the optional input
terminals.

6:@E):@_Crimp-on lug with insulation sleeves (for 4 mm screws)

Wiring Procedure
As shown in the figure on next page, the optional terminal block is located on the rear panel. The

optional terminal block is provided on the DX when an option that requires input/output is installed
such as the alarm output relay (/A[ ] option), FAIL/status output relay (/F1 or /F2 option), and
remote control function (/R1 option), etc. A terminal cover is screwed in place on the measuring
input terminal block. A label indicating the terminal arrangement is affixed to the cover.

1. Turn OFF the DX and remove the terminal cover.

2. Connect the signal wires to the terminals.

3. Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 Nem.
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Installation and Wiring

Arrangement of the Optional Terminals

Optional terminal block 3 —

Optional terminal block 4

PE=Y

(. w wY

%
[ © [ hoac]
QQI

- Optional terminal block 1

- Optional terminal block 2

| Description of Symbols

Symbols such as "NC": Terminal functions

Alarm output, FAIL/status output| Remote control input
1 to 8: Terminal number

NC: Normally closed
C: Common C: Common
NO: Normally opened

Aterminal that is not used. (With a screw)
|:| A terminal that is not used. (Without screw)

Pulse input
Hand L: See page 61.

Transmitter power supply
+and - See page 61.

| Options That Use Option Terminal Block 1 Only

These options can come with /TPS4 or /TPS8.
In that case, the option terminal block 4, or option terminal blocks 3 and 4 are installed.
For the terminal arrangement for /TPS4 and /TPS8, see page 57.

I1A2
Alarm Alarm
output output
02 01 04 03 02 01
&) GG |GDNe| |NC &) GOINC| [Nc|Nc| INC
S @@ @<l [c @ |@lc| [clc| |c
& G)ED|  |DNo|  |No @ (GY|No| |No|NO| [NO
IA1/R1 IA2/R1
Alarm Remote Alarm Remote
output control output control
input input
022 01— 04 0302 01—

NC NC| 6 |3 | ¢ NC

NC|NC NC| 6

c| |c|7|a4

c|C c

V@
SO0
QR®
VR®
®§®

No| [NO|8 |55 NO

NO|NO NO(8 | 5

/R1 /A1 /F1
Remote Status Alarm
control output output
input FAIL —

— v l 02 01
6|3[c| N [NC[3®) (INc| |NC
7(4f7] 5] [c|@ @] |c
8|5, N9 [NO|GD| [@D[NO| [NO

(To next page)

C
1
2

A3
Alarm
output
A
r N\
06 0504 0302 01
NC| Inc|nc| [Nc|ne| [Nnc
c clc clc c
NO|  Ino|no| |No|NO|  [NO
IA3/R1
Alarm Remote
output control
P A N input
06 0504 0302 01—
NC| Inc|nc| |ncinc| |Ncl6 (3¢
Cl |cle| |clc| |c|7]alq4
NO| nolno| |Nojno| [NO|8 |5 |,
A2 IF1
Status Alarm
output output
FAIL
l 04 0302 01
NC| Inc|nc| |Ncine| [nc
c clc clc c
NO| Ino|no|  [No|no|  [NO

56
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Installation and Wiring

(From previous page)

IF1 /A1 [F1 /R1 /A2 I[F1 /IR1
Status Status Alarm Remote Status Alarm Remote
output output output control output output control
FAIL FAIL —"——  input FAIL ————————  input
l l 02 01— l 04 0302 01—
NC Inel® D) | NCI INc[GD] |@)INc| [Nc|6|3[c| INS| |nc|nc| |nc|nc| [Nc|6 |3 (¢
‘[ Telel @ @ oI el @lc| lelr]efx] (€] [cle] lele] lel7]es
NOl Ino[®) IR (D@ NOl  Ino|@D)| |@INo| |No|8 |5 [, | [NO| |Nojno| [No[no| [No|s |5 [
IF1 /R1 /A1 /PM1 IA2 /IPM1
Status Remote Alarm Remote Alarm Remote
output control output ﬁ’#pl,slﬁ control output ﬁ’#pl,slﬁ control
FAIL input — 0 input — —A— input
l — 02 0 g, ¢ —— 04 0302 01 TG, o
N[ Ine@ [RIB] (@ e[l @ [R@Ine] [ne H{H[H[3[c] N [Nc|Nc| [Nc| |H|H|H|3[¢
cl cl@ @@ @7]aq1 @ @c| [c| [clolc]alfz] S [cle| [c| [cc|L]aly
N[ vl |RIB] (@ e |52 [ |®@INo| [No 55| N9 [no|No| [no 2
/A1 /F1 /PM1 /PM1 IF1 /PM1
Stat
ot?t;ust Alarm Pulse Remote Pulse Remote Status Pulse Remote
output input  control input  control output input  control
FAIL — —A— input A input FAIL A input
02 01 8 7 6 8 7 6 l 8 7 6/ '
NC| Inc|nc| |Nc| |H|H|H|3[¢ HIH|H|[3[c] IN¢| [Nc|GD (@D [H|H|H|3 [
Cl lcle| [c| |L|L|L|afy Llefefafq] (S |[c[@ (@) |i|c|c|aly
NO|  INo[No| [no 5[5 505 N9 [no@) (6D 2
[TPS4 2
[
Transmitter power supply 5._=>
A g.
@ 4]+ »
=]
Y o 2
s
=
=}
@
ITPS8
Transmitter power supply

/_/%

@++++

Transmitter power supply

/_/%

@++++
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| Options That Use Option Terminal Blocks 1 and 2
Erg /A3 [F1 /A3 IF1 IR1
@@ Status Status Remote
output output control
FAIL FAIL input
ey 7 | o R

i@ @@ @) @ i@ @@ (@6 [2]c] @
[T warv—w C C
— | — c® ¥ @ c® & @744
—————— I\o NO
N B (@) NOIED) (@) (@) |5
Alarm Alarm
output output
Ie A N\ P A \
6 1514 1312 11 6 1514 1312 11
NC| Inc|nc| |Nc|ne|  [Ne ® NC| Inc|nc| |Nc|ne|  [Ne ®
c c
clc clc c clc cle c
NO| |no[no| |No|No| [NO NO| |no[no| |No|No| [NO
/A3 /PM1 /A3 [F1 /PM1
Pulse  Remote Status Pulse  Remote
input c_ontr(t)l EAIL output input cpntr(t)l
— Inpu — Inpu
8 7 67 v l 8 7 6 =
HIHIH|3 ] @ N INc[@) 1@ |H[H|H[3[c] (@D
LiL|L|a[q] €l [c|@® (60 |vi|i|L|a[;
5(2 ] NO| [nol@) @) 52
Alarm T Alarm
output output
Ie A N\ P N \
16 1514 1312 11 6 1514 1312 11
NCl Inc|nc| |Nc|ne|  [Ne ] @ NC| Inc|nc| |Nc|ne|  [Ne )
c — c
cle cle c clc cle c
NO| |no[no| [No|NO| [NO ] NO| |No[no| [No[NO| [NO
A4 /A4 |IR1
Alarm Alarm Remote
output output control
r A N r A N input
06 0504 0302 01 06 0504 0302 01
NC| INc|Nc| |Nc|Nc| [Nc @ NC| Inc|nc| |Nc|nc| |Nc|e |3 [¢ @D
c c
clc clc c cle clc cl7/4ly
NO|  INo|No| [No|no| [NO NO|  INo|No| [No|no| [No|8 |5 |5
Alarm Alarm
output output
Ie A N\ P A \
6 1514 1312 11 6 1514 1312 11
NCl  Inc|nc| |Nc|ne|  [Ne @ NCl  Inc|nc| |Nc|ne|  [Ne )
c c
clc clc c clc clc c
NO|  Ino|no| |No|NO|  [NO NO|  Ino|no| |No|NO|  [NO

These options can come with /TPS4 or /TPS8.
In that case, the option terminal block 4, or option terminal blocks 3 and 4 are installed.
For the terminal arrangement for /TPS4 and /TPS8, see page 57.
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| Options That Use Option Terminal Blocks 1, 2, and 3 |

/A4 IF1
Alarm
ouf\put %tuattsjust
. \ FAIL
26 2524 2322 21 v l
® N INc|nc| |Nc|Nc| [nc NCI el [0 | O)
€| |ele| |ele| e ‘I [c® @@ @
NO|  Ino|no| [No[no| [NoO NOI Ino|®) (DD (&)
Alarm
output
r A hY
16 1514 1312 M
NC| Inc|ne| [Nc|nc|  |Ne ®
Cl |clc| |ele| |c
NO| Ino|no| |No|No| |NO
/A4 IF1 IR1
Alarm Status Remote
ouﬁput output control
r \ FAIL input
26 2524 2322 21 v
@ [N |nc|nc| |Nc|Nc| |Nc NI INc|® (G0 () s 3[c|@
c clc clc c ¢ c@ DD 7|41
NO|  Ino[no| [No[No| [NO NOl Ino|@)  [®GD| (@) s |55
Alarm -
output
r A hY
16 1514 1312 N
NC| Inc|ne| [Nc|Nc| |Ne 1@ =
- 2
€| lclec| |c|c| |c g
NO|  INo|no| [No|No| |NO ] %’.
— =
/A4 /|PM1 o
Alarm o
Pulse
. 0u££>ut . input §
s
26 2524 2322 21 % 7 8 —— 3
3 [N¢| |nc|nc| |Nc|Nc| |Nc HIH|H|3 ] (@D
€| lclc| |c|c| |c Lic|L|4fq]
NO|  |No|No| [No|no| |NO 5[5
Alarm T
output
r A N\
16 1514 1312 N
NC| Inc|nc| |Nc|ne|  |Ne 1@
| |clc| |ele| |c |
NO| Ino|no| [No[no|  |No ]
/A4 [F1 PM1
Alarm Status Pul Remote
, output . FAIL output irlilpsiﬁ c_ontr(t)I
in
26 2524 2322 21 v B 7 6~
@ N |Nc|nc| |Nc|Nc| [nc NC| Inci@d [@) [H[H[H[3[c] @
€l lecle| [clc]| |c | |cl@ @ [c|c|L|afq]
NO|  |No|No| [No[No| |NO NOl N0l (@) 5[,
Alarm -
output
A
r hY
16 1514 1312 N
NC| Inc|ne| [Nc|ne| |Ne 1@
These options can come with /TPS4. c clc cle P =
In that case, the option terminal block 4 is installed. |
For the terminal arrangement for /TPS4, see page 57. NO| Ino|No| |No|No| |NO
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Options That Use Option Terminal Blocks 1, 2, 3, and 4

IA5
Alarm Alarm
output output
r A N\ r A N\
26 2524 2322 21 06 0504 0302 01
® NC| Inc|nc| |Nc|nc|  |Ne NC| Inc|nc| |Nc|ne|  |Ne ©)
c cle| lcle| |c c cle| |cle| e
NO|  Inolno| |No|NO| [NO NO| Inolno| |No|No| [NO
Alarm Alarm
output output
r A N\ r A N\
36 3534 3332 31 16 1514 1312 11
@ NCl Inc|nc| |Nc|nc|  |Ne NC| Inc|nc| |Nc|nc| |Ne @
c cle| lele| |c c cle| |cle| |ec
NO|  Ino|no| |No|NO| [NO NO|  Inolno| |No|No| [NO
/A5 IR1
Alarm Alarm Remote
output output control
r A N r A N input
26 2524 2322 21 06 0504 0302 01
® NC|  Inc|nc| |Nc|nc| |Nc NC| INc|Nc| |Nc|nc| |Nc|e |3 [¢ @
€l |c|c| |c|c| |c €l |clc| [c|c| |c|7|a[y
NO|  |No|No| |no[no| |NO NO|  No[No| [No[No| [NO|8 |5 |5
Alarm Alarm
output output
r A N\ r A Y
36 3534 3332 31 16 1514 1312 1
0) NC| Inc|nc| [Nc|ne| [Ne NC Inc|nc| [Nc|ne| [Ne @
c cle clc c c cle clc c
NO|  Ino|no| |No|NO| [NO NO|  Ino|no| |No|No| [NO
IF2
Alarm Status Alarm
. ou/t\put . output output
26 2524 2322 21 04 0302 01
® NC| Inc|nc| |Nc|nc|  |Ne NC| Inc|nc| [Nc|ne| [Ne ©)
c cle| |cle| |c c cle| |clc c
NO| Ino|No| |No|NO| [NO NO|  Inolno| |No|NO| [NO
Alarm Alarm
output output
A A
r N\ r N\
36 3534 3332 31 6 1514 1312 11
@ NC| Inc|nc| |Nc|nc|  |Ne NC| Inc|nc| |Nc|nc|  |Ne @
c clc clc c c cle clc c
NO|  Ino|No| |No|NO| [NO NO|  Ino|no| |No|No| [NO
IF2 /IR1
Alarm Alarm Remote
output %Latgjust output control
I A N FAIL input
26 2524 2322 21 04 0302 01
® N |nc|nc| |Nc|nc| e NC| INc|Nc| [nc|nc| [ncls |3 [c] (D
€l lec|e| |clc]| |c €l lclc| |c|c| |c|7]a];
NO|  |No|No| |No[No| |NO NO|  INo[no|  [NO|NO| [NO| 8 |5 [
Alarm Alarm
output output
A A
r N\ r N\
36 3534 3332 31 16 1514 1312 11
@ NC| Inc|nc| |Nc|nc|  |Ne NC| Inc|nc| |Nc|nc|  |Ne ®
c clc clc c c cle clc c
NO|  Ino|No| |No|NO| [NO NO|  Ino|no| |No|No| [NO
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Installation and Wiring

Alarm Output Terminal, FAIL Output Terminal, and Status Output Terminal
(/A1, /A2, IA3, IA4, IAS5, [F1, and /F2)
NC

Output format: Relay contact
c Contact rating: 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistor load)
NO Withstand voltage: 1600 VAC at 50/60 Hz for one minute

(between output terminals and the ground terminal)

Remote Control Input Terminal (/R1)

* Relay contact input
(voltage-free contact)
Contact closed at 200 Q
Contact open at 100 kQ or greater

* Transistor input (open collector)

ON voltage: 0.5V or less (30 mADC)
Leakage current when turned OFF:

Internal circuit

\'
Input format:
Photocoupler isolation

025 mA or Ie_ss_

-

Shared common (C)
Allowable input voltage:

3
4
5

Withstand voltage: 1000 VDC for one minute between
input terminals and the ground terminal

Pulse Input Terminal (/PM1)

* Relay contact input
(voltage-free contact)
Contact closed at 200 Q or less
Contact open at 100 kQ or greater
0.25 mAor less

i

C
1

* Transistor input (open collector)

ON voltage: 0.5V or less (30 mADC)
Leakage current when turned OFF:

T"%T’%T’%E C%[’ C%f {gf

Withstand voltage: 1000 VDC for one minute between
input terminals and the ground terminal

8 5VDC
Cﬁ

Internal circuit

5V Input format:
Photocoupler isolation

‘ Shared common (L)
Allowable input voltage:
30 VvDC

24 VDC Transmitter Power Supply Output Terminal (/TPS4 and /TPS8)
Connect the DX to the transmitter as shown below.

DX

Current

Transmitter power
supply output
terminal

Input terminal

Note

Shunt resistor: 250 Q

Transmitter

To reduce noise, use a shielded cable for wiring. Connect the shield to the functional ground

terminal or the ground terminal of the DX.

Serial Interface

Connecting to the RS-232 Connector (/C2)

12345 2 RD (Received Data): Received data from the PC. Input signal to the DX.
\ | | | 3 SD (Send Data): Transmitted data to the PC. Output signal from the DX.
1 5 SG (Signal Ground): Signal ground.
@ 000 @ 7 RS (Request to Send): Handshaking signal when receiving data from the PC. Output signal
from the DX.
(/; -’, L \9 8 CS (Clear to Send): Handshaking signal when transmitting data to the PC. Input signal to

the DX.

*Pins 1, 4, 6, and 9 are not used.
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Installation and Wiring

Connecting to the RS-422A/485 (/C3)
Four-wire system Two-wire system _—I

o|lo|o|ao o FG (Frame Ground) Frame ground of the DX.
SG (Signal Ground) Signal ground.

@ @ @ @ @ SDB (Send Data B) Send data B (+).

o o [I
SDA (Send Data A) Send data A (-).
= ' RDB (Received Data B) Receive data B (+).

1 i RDA (Received Data A) Receive data A (-).

o

@

O O g

FG SG SDB SDA RDB RJ.A FG SG SDB SDA RDB RDA
Electric * . Electric .
potential <— Shield potential <— Shield

of the shield of the shield
Recommended length of stripped wire: 9 mm. Recommended tightening torque: 0.4-0.5 Nem.

Cable
There are two types of cables available, the four-wire cable and the two-wire cable (used only for the Modbus protocol).
The cable should meet the following specifications.
 Type: Shielded twisted pair cable: 3 pairs 24 AWG or more (four-wire),
2 pair 24 AWG or more (two-wire)
* Characteristic impedance: 100 Q
» Capacitance: 50 pF/m
« Total cable length: Upto 1.2 km

Connecting to the VGA Connector (/D5)

A CAUTION

» Connect the cable after turning OFF the DX and the monitor.
» Do not short the VIDEO OUT terminal or apply external voltage to it. If you do,
the DX may malfunction.

VGA Output Terminal
VIDEO OUT(VGA) A

00000
©o0o0o00
coooo
)

The DX display can be output to a monitor through the RGB output. Connectable
monitors are VGA monitors or multi-sync monitors capable of displaying VGA.

Specifications of the VGA Output Terminal

Pin No. Signal Name Specifications
1 Red 0.7 Vp-p
2 Green 0.7 Vp-p
5 1 3 Blue 0.7 Vp-p
4 -
5 —
OO0 O0OO0O0 6 GND
10 O 0O 67 GND
(ONORONONG) 8 GND
9 -
10 GND
15 1" 1 _
D-Sub 15-pin receptacle 12 -
13 Horizontal sync Approx. 31.5 kHz, TTL
signal negative logic
14 Vertical sync signal  Approx. 60 Hz, TTL

negative logic

-
[
|
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Installation and Wiring

Connecting to the Monitor
1. Turn OFF the DX and the monitor.

2. Connect the DX and the monitor using an analog RGB cable.
3. Turn ON the power to both the DX and the monitor. The DX screen is displayed
on the monitor.
Note
*  When the DX is turned ON, a VGA signal is always output from the VIDEO OUT terminal.
» The monitor screen may flicker if the DX or another instrument is brought close to the
monitor.
* The edge of the screen may drop out depending on the monitor type.

Connecting to the USB Port (/USB1)
The USB port complies with Rev. 1.1.

Front Rear

USB port

Connecting to the Ethernet Port
Ethernet port

Indicator

5
7}
-
S
o
=
o
=
o
=3
2
=
5
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Checking the Connection/Communication Status
The connection status of the Ethernet interface can be confirmed with the indicator that is

located to the upper right of the Ethernet connector of the DX.

Indicator Connection Status of the Ethernet Interface
llluminated (green) The Ethernet interface is electrically connected.
Blinking (red) Transmitting data.

Off The Ethernet interface is not electrically connected.

Checking the Connection on the DX Display

¢ Checking the Connection at the status indication section of the DX display
You can check the connection status of the Ethernet interface on the Ethernet Link
indicator located on the right side of the status indication section of the basic setting
mode display. The basic setting menu appears by pressing MENU to display the
setting menu followed by FUNC for approximately 3 s.

¢ Checking the Connection Status in the Display Section in the Upper
Right Corner of the Communication Log Display of the DX
You can check the connection status of the Ethernet interface on the Link indicator on
the display section in the upper right corner of the communication log display.

Indicator Connection Status of the Ethernet Interface
llluminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.
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Installation and Wiring

Power Supply Wiring

Panel Mount Type, or Desktop Type with /P1 Option (Models with /H5 and /P1 Options)
Precautions to Be Taken While Wiring the Power Supply

Make sure to follow the warnings below when wiring the power supply. To prevent electric
shock and damage to the DX, observe the following warnings.

A

To prevent electric shock when wiring, ensure the main power supply is turned OFF.
To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20 to 16) or
an equivalent wire for power wiring.
Make sure to earth ground the protective earth terminal through a grounding
resistance less than 100 Q before turning ON the power.
Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply
wires and protective grounding wires.
To prevent electric shock, make sure to close the transparent cover for the
power supply wires.
Make sure to provide a power switch (double-pole type) on the power supply line in
order to separate the DX from the main power supply. Put an indication on this switch
as the breaker on the power supply line for the DX and indications of ON and OFF.
Switch specifications
Steady-state current rating: 1 A or more (other than /P1), 3 A or more (/P1).
Inrush current rating: 60 A or more (other than /P1), 70 A or more (/P1).
Use a switch complies with IEC60947-1, 3.
Connect a fuse (between 2 A and 15 A) to the power line. Use a fuse approved
by CSA (for the use in North America) or VDE (for the use in Europe).
Do not add a switch or fuse to the ground line.

Use a power supply that meets the following conditions:

Item Other than /P1 /P1

Rated supply voltage 100 to 240 VAC 24 VDC/AC

Allowable power supply voltage range 90 to 132/180 to 264 VAC 21.6V to 26.4 VDC/AC

Rated power supply frequency 50/60 Hz 50/60 Hz (for AC)

Allowable power supply frequency range  50/60 Hz + 2% 50/60 Hz+2% (for AC)
Maximum power consumption 74 VA (100 V)/100 VA (240 V) 45 VA (for DC), 70VA (for AC)
Nofte

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Wiring Procedure

1. Turn OFF the power to the DX and open the transparent power terminal cover.
2. Wire the power cord and the protective ground cord to the power supply terminals.

Use ring-tongue crimp-on lugs (designed for 4 mm screws). The proper torque for
tightening the screw is 1.4 to 1.5 Nem (12.4 to 13.2 inchelbs).

Other than /P1 IP1
(24 VDC/AC power supply)
100-240V  AC~ 24VDC 28\A MAX
50/60Hz 60VA MAX 24V AC ~50/60Hz 45 MAX
N & O &
Note

Do not wire the protective grounding
cord to the functional ground terminal.

Replace the power terminal cover, and fasten it with screws.
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Installation and Wiring

Desktop Type

Precautions to Be Taken While Connecting the Power Supply

Make sure to follow the warnings below when connecting the power supply. To prevent
electric shock and damage to the DX, observe the following warnings.

A

Before connecting the power cord, ensure that the source voltage matches the
rated supply voltage of the DX and that it is within the maximum rated voltage
range of the provided power cord.

Connect the power cord after checking that the power switch of the DX is turned
OFF.

To prevent electric shock or fire, be sure to use the power cord supplied by
YOKOGAWA.

Make sure to perform protective earth grounding to prevent electric shock.
Connect the power cord of the desktop type to a three-prong power outlet with a
protective earth terminal.

Do not use an extension cord without protective earth ground. Otherwise, the
protection function will be compromised.

Use a power supply that meets the following conditions:
Item Condition
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range 90 to 132, 180 to 264 VAC
Rated power supply frequency 50/60 Hz
Allowable power supply frequency range 50/60 Hz + 2%

Maximum power consumption

74 VA (100V) and 100 VA (240 V)

Note

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Connection Procedure

1.

Check that the power switch is OFF.

2. Connect the power cord plug to the power connector on the rear panel. (Use the

power cord that comes with the package.)

3. Check that the power outlet meets the conditions given in the table above and

that the supply voltage is within the maximum rated voltage range of the power
cord that comes with the package. Then, connect the other end of the power cord
to the power outlet. The AC outlet must be of a three-prong type with a protective
earth ground.
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Recommended Replacement Periods for Worn Parts

Maintenance

To preserve the reliability of the DX and to use the DX in a good condition for an
extended time, it is recommended that periodic replacements be made on parts. The
following table shows the recommended replacement period for expendable parts.

The replacement period shown here applies when the recorder is used under standard
operating conditions. For the actual replacement period, consider the actual conditions
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or an
engineer certified by YOKOGAWA. Contact your nearest YOKOGAWA dealer when such
replacement is necessary.

Item g:z:)a:ement Name Part No. gzzgtlty Notes

LCD 5 years Back Light Unit B9968PA 1

Battery 10 years Battery Assembly B9900BR 1

Dust and water 5 years Packing B8706FY 1

proof strip 5 years Key Case Assembly B8706BM 1 English specifications

5 years Key Case Assembly B8706BY 1 Japanese specifications

Aluminum 5 years* Power Supply Assembly |- 1

electrolytic capacitor |5 years* AD Assembly Depends on the model

*

Replacement period at the upper limit of the normal operating temperature (50°C)

The replacement period varies depending on the operating temperature and the specifications of the DX.
The lower the operating temperature, the longer is the replacement period. For example, if the operating
temperature is 30°C, it may be possible to use the parts for more than 10 years.

Note

» The LCD replacement period indicates the half life of the brightness when the brightness
is set to the factory default setting. The half life is shortened as the brightness is set
higher. The deterioration of brightness varies depending on the condition of use, and its
determination is subjective. Consider these facts for determining the actual replacement

period.

* The color of the LCD may become yellowish as time elapses. The discoloration tends to
progress faster as the brightness is set higher.
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Setup Items and Default Values

The setup items and the default values in the setting mode are listed below. Enter the
settings that you are using in the Setting column for your convenience.

Setting mode menu
GROUP 1 = :
onps/12/81 g2-pe-as  hd DIsP I 16min @
Page 68

Heas channel ® b Page 68 to 70
Math channel ® b Page 71 and 72"
Ext- channel ® > Page 73"
Display @ 4 Page 74

Group set, Trip line ® Page 74
fessase @ Page 74

Timer, Event action @ » Page 75

Data saue @ ¥ Page 76

Save/Load ® b Page 76

Menu custonize @ b Page 76

*: Options

Basic setting mode menu

Basic Setting Hode

Setting menu |

Page 77

/D, femory ® Page 77

Burnout. RJC @ Page 77

Environment @ > Page 77 and 78
Keylocke Page 78

Logine > Page 79°

Report @ > Page 79’

Time settings @ Page 79

Load settings, Initialize® b Page 79
Comnunication (Ethernet) @ » Page 80 and 82
Communication (Serial) ® b Page 82’

Status relay @ Page 83

End ® Page 83

1: Options
2: Displayed when the function is enabled in the Environment settings.

A
o
o3
£ 3
o

23
0 >
- Q
Sg
7
El-X
T3
L o
2 3
®
=
=

sanjep jnejaq
pue swd)| dnjag
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Setup Items and Default Values

Date/Time > Time settings

Setup Item Selectable Range or Selections Default Value Setting
Time set — —
Date/Time > Daylight Saving Time
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ APR
OCT/NOV/DEC
Start time > Day order 1st/2nd/3rd/4th/Last 1st
Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Start time > Hour of the day Numerical value 2
End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ OCT
OCT/NOV/DEC
End time > Day order 1st/2nd/3rd/4th/Last Last
End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
End time > Hour of the day Numerical value 1
Meas channel > Range, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number
Range > Mode Skip/Volt/TC/RTD/Scale/Delta/DI/ Volt
1-5V/Sqrt
Mode=Volt
Range 20mV/60mV/200mV/2V/6V/20V/50V 2V
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Mode=TC
Range R/S/B/K/EIJIT/IN/WIL/U/WRe R
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Mode=RTD
Range Pt/JPt Pt
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Mode=Scale
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —-30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less
Mode=Delta
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Ref.CH Meas channel number -
Mode=DI
Range Level/Cont Level
Span Lower 0,1 0
Span Upper 0,1 1
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Setup Items and Default Values

Setup Item Selectable Range or Selections Default Value Setting
Mode=1-5V
Range 1-5V 1-5V
Span Lower 0.800 to 5.200 1.000
Span Upper 0.800 to 5.200 5.000
Scale Lower —30000 to 30000, decimal position :0 to 4 0.00
Scale Upper —30000 to 30000, decimal position :0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Mode=Sqrt
Range 20mV/60mV/200mV/2V/6V/20V/50V
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Low-cut value 0.0t0 5.0 0.5
Alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/h:delta H/l:delta L/R:rate H/ H
rirate L/T:delayH/t:delayL
Value Numerical value -
Relay On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the model.)
S01/S02/S03/.../1S29/S30
Detect On/Off On
Meas channel > Tag, Memory sample, Alarm delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1
Tag > Tag 16 characters or less —
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
Meas channel > Moving average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1
Moving average > On/Off On/Off Off
Moving average > Count 2 to 400 2
Meas channel > Color
Setup Item Selectable Range or Selections Default Value Setting
Group of channel 001-010, etc Depends on the model.
Color Red/Green/Blue/B.violet/Brown/Orange/ Red to Gray

Y.green/Lightblue/Violet/Graly/Lime/Cyan/

Darkblue/Yellow/Lightgray/Purple/Black/Pink/
L.brown/L.green/Darkgray/Olive/DarkCyan/

S.green (24 colors)
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Setup Items and Default Values

Meas channel > Zone, Scale, Bar graph

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1

Zone > Lower 0to 95 0

Zone > Upper 5to 100 100

Scale > Position Off/1/2/3/4/516/7/8/9/10 1

Scale > Division 4/5/6/7/8/9/10/11/12/C10 10

Bar graph > Base position Normal/Center/Lower*/Upper* Normal

Bar graph > Division 4/5/6/7/8/9/10/11/12 10

* A function available on DXs with release number 2 or later.

Meas channel > Partial

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1

On/Off On/Off Off

Expand 1t0 99% 50

Boundary Span Lower+1digit to Span Upper-1digit 0.0000

Meas channel > Alarm mark, Color scale band

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1

Alarm mark > Mark kind Alarm/Fixed Alarm

Alarm mark > Indicate on Scale On/Off Off

Alarm mark > Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red

Alarm mark > Alarm mark color > Alarm 2 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 3 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 4 Same as Alarm 1 Red

Color scale band > Band area Off/In/Out Off

Color scale band > Color Red/Green/.../S.green (24 colors) Lime

Color scale band > Display position > Lower ~ Measuring range 0.0000

Color scale band > Display position > Upper Measuring range 0.0100

Meas channel > Calibration correction

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number

1

Number of set points Off/2/3/4/5/6/7/8/9/10/11/12/13/14/15/16

Off

1 ton > MES val
1ton > True val

Value in the measuring range/measured value
Measuring range
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Setup Items and Default Values

Math channel > Calculation expression, Alarm

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Math range > Math On/Off On/Off Off
Math range > Calculation expression 120 characters or less -
Math range > Span Lower —9999999 to 99999999, decimal position: 0 to 4 —200.00
Math range > Span Upper —9999999 to 99999999, decimal position: 0 to 4 200.00
Math range > Unit 6 characters or less —
Math alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL -
Value Numerical value -
Relay On/Off On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the model.)
S01/S02/S03/.../S29/S30
Detect On/Off On
Math channel > Constant
Setup Item Selectable Range or Selections Default Value Setting
Number of constant K01 to K60 K01
Value —9.9999E+29 to —1.0000E-30, 0, 1
1.0000E-30 to —9.9999E+29
Math channel > Tag, Memory sample, Alarm delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Tag > Tag 16 characters or less —
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
Math channel > TLOG, Rolling average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
TLOG > Timer No. 1/2/3/4 1
TLOG > Sum scale Off, /s, /min, /h Off
TLOG > Reset On/Off Off
Rolling average > On/Off On/Off Off
Rolling average > Interval 1s/2s/3s/4s/5s/6s/10s/12s/15s/20s/30s/ 10s
1min/2min/3min/4min/5min/6min/10min/12min/
15min/20min/30min/1h
Rolling average > Number of samples 1 to 1500 1
Math channel > Color
Setup Item Selectable Range or Selections Default Value Setting
Group of channel 101-110, etc Depends on the model.
Color Red/Green/.../S.green (24 colors) Red to Gray

Math channel > Zone, Scale, Bar graph
Same as Meas channel.
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Setup Items and Default Values

Math channel > Partial

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101

On/Off On/Off Off

Expand 1to 99% 50

Boundary Span Lower+1digit to Span Upper—1digit  0.00

Math channel > Alarm mark, Color scale band

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101

Alarm mark > Mark kind Alarm/Fixed Alarm

Alarm mark > Indicate on Scale On/Off Off

Alarm mark > Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red

Alarm mark > Alarm mark color > Alarm 2 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 3 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 4 Same as Alarm 1 Red

Color scale band > Band area Off/In/Out Off

Color scale band > Color Red/Green/.../S.green (24 colors) Lime

Color scale band > Display position > Lower ~ Measuring range 0.00

Color scale band > Display position > Upper ~ Measuring range 1.00

Math channel > Math start action

Setup Item Selectable Range or Selections Default Value Setting

Math start action > Math start

Off/Start/Rst+St

Start
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Setup Items and Default Values

Ext. channel > Range, Alarm

Setup Item

Selectable Range or Selections

Default Value Setting

First-CH, Last-CH

Channel number

201

Ext. range > On/Off On/Off Off
Ext. range > Span Lower —30000 to 30000, decimal position: 0 to 4 —200.00
Ext. range > Span Upper —30000 to 30000, decimal position: 0 to 4 200.00
Ext. range > Unit 6 characters or less -
Ext. alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL -
Value Numerical value -
Relay On/Off On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the model.)
S01/802/S03/.../S29/S30
Detect On/Off On
Ext. channel > Tag, Memory sample, Alarm delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 201
Tag > Tag 16 characters or less —
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10

Ext. channel > Color

Setup Item

Selectable Range or Selections

Default Value Setting

Group of channel

201-210/211-220/221-230/.../421-430/
431-440

201-210

Color

Red/Green/.../S.green (24 colors)

Red to Gray

Ext. channel > Zone, Scale, Bar graph

Same as Meas channel.

Ext. channel > Partial, Alarm mark, Color scale band

Same as Math channel.
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Setup Items and Default Values

Display > Trend (Circular)/Save interval

Setup Item

Selectable Range or Selections

Default Value Setting

Trend/Save interval
Trend interval [/div]

Save interval
Second interval [/div]

15s/30s/1min/2min/5min/10min/15min/20min/ 1min
30min/1h/2h/4h/10h

10min to 31day (Depends on the trend interval.) 1h
15s/30s/1min/2min/5min/10min/15min/20min/ 1min
30min/1h/2h/4h/10h

Circular/Save interval
Time per revolution [/rev]

Save interval
Offset time

20min/30min/1h/2h/6h/8h/12h/16h/1day/
2day/1week/2week/4week

1day

10min to 31day (Depends on the time per revolution.) 1h
Off/1h to 23h (Depends on the time per revolution.) Off

Display > Trend (Circular), Bar graph, LCD, Monitor

Setup Item Selectable Range or Selections Default Value Setting
Trend
Trend > Direction Horizontal/Vertical/Wide/Split Horizontal
Trend > Trend clear On/Off Off
Trend > Message direction Horizontal/Vertical Horizontal
Trend > Scale > Digit Normal/Fine Normal
Trend > Scale > Value indicator Mark/Bargraph Mark
Trend > Trend line 1/2/3 2
Trend > Grid Auto/4/5/6/7/8/9/10/11/12 Auto
Circular
Circular > Full circle action Allclear/Divclear Allclear
Circular > Trend line 1/2/3 2
Circular > Grid Auto/4/5/6/7/8/9/10/11/12 Auto
Bar graph > Direction Horizontal/Vertical Vertical
LCD > Brightness 1/2/3/4/5/6 2
LCD > Backlight saver > Mode Off/Dimmer/Timeoff Off
LCD > Backlight saver > Saver time 1min/2min/5min/10min/30min/1h 1h
LCD > Backlight saver > Restore Key, Key+Alarm Key+Alarm
Monitor > Background > Display White/Black White
Monitor > Background > Historical trend White/Cream/Black/Lightgray Black
Monitor > Scroll time 5s/10s/20s/30s/1min 10s
Monitor > Jump default display Off/1min/2min/5min/10min/20min/30min/1h Off

Group set, Trip line

Setup Item

Selectable Range or Selections

Default Value

Setting

Group number

1/2/3/...135/36

1

Group set > On/Off

Group set > Group name
Group set > CH set

On/Off

GROUP1 to GROUP36/16 characters or less
39 characters or less

Group 1to 4: On
Group 5 to 36: Off
GROUP1 etc.
Depends on the model.

Trip line > 1 On/Off Off

Trip line > 2 On/Off Off

Trip line > 3 On/Off Off

Trip line > 4 On/Off Off

Trip line > Position 0to 100 50

Trip line > Color Red/Green/.../S.green (24 colors) 1:Red, 2:Green
3:Blue, 4:Yellow

Trip line > Line width 1/2/3 2

Message

Setup Item Selectable Range or Selections Default Value Setting

Message No. 1-10/11-20/21-30/31-40/41-50/51-60/ 1-10

61-70/71-80/81-90/91-100

Message 1 to 100

32 characters or less
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Setup Items and Default Values

Timer, Event action > Timer

Setup Item Selectable Range or Selections Default Value Setting
Timer No. 1/2/3/4 1
Mode Off/Relative/Absolute Off
Relative > Interval 00:01 to 24:00 01:00
Relative > Reset at Math Start On/Off On
Absolute > Interval 1min/2min/3min/4min/5min/6min/10min/ 1h
12min/15min/20min/30min/1h/2h/3h/4h/
6h/8h/12h/24h
Absolute > Ref.time 0to 23 0:00
Timer, Event action > Match time timer
Setup Item Selectable Range or Selections Default Value Setting
Timer number 1/2/3/4 1
Kind Off/Day/Week/Month Off
Day 1to 28 1
Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Hour 00:00 to 23:59 00:00
Timer action Single/Repeat Repeat
Timer, Event action > Event action
Setup Item Selectable Range or Selections Default Value Setting
Logic box number 1/2/3/.../139/40 1
Event None/Remote/Relay/Switch/Timer/ None
Matchtime/Alarm/UserKey
Remote > Remote number 1/2/3/415/6/7/8 1
Relay > Relay number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the model.)
Switch > Switch No. S01/S02/S03/.../1S29/S30 S01
Timer > Timer No. 1/2/3/4 1
MatchTimeTimer > Match Time Timer No.  1/2/3/4 1
Action MemoryStart/Stop, MemoryStart, Group
MemoryStop, Trigger, AlarmACK, MathStart/
Stop, MathStart, MathStop, MathReset,
SaveDisplay, SaveEvent, Message, Snapshot,
DisplayRate1/2, ManualSample, TimerReset,
DisplayGroupChange, Flag, PanellLoad,
TimeAdjust
Message > Message No. 110 100 1
Message > Write to All/Select All

Message > Group number
Group > Group number

Flag > Flag number
TimerRst > Timer No.
PnlLoad> Setting file number

1/2/3]...135/36
1/2/3/...135/36
1/2/3/4/5/6/7/8
1/2/3/4

1/2/3
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Setup Items and Default Values

Data save > File header, Data file name

Setup Item Selectable Range or Selections Default Value Setting
File header > Characters 50 characters or less -
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less —
Data save > Save directory
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less DATAO
Data save > Event data
Setup Item Selectable Range or Selections Default Value Setting
Sample rate 25ms/125ms/250ms/500ms/1s/2s/5s/10s/ 1s
30s/60s/120s/300s/600s (Depends on the model.)
Mode Free/Single/Repeat Free
Data length 10min to 31day (Depends on the sample rate.) 1h
Pre-trigger 0/5/25/50/75/95/100 0
Trigger signal > Key On/Off On
Data save > Manual sample
Setup Item Selectable Range or Selections Default Value Setting
Manual sample number 001 to 120 001
On/Off On/Off On
Channel Channel number 001
Data save > Batch text
Setup Item Selectable Range or Selections Default Value Setting
Text field number 1/2/3/4/5/6/7/8 1
Text field > Title of field 20 characters or less -
Text field > Characters 30 characters or less -
Save/Load
Setup Item Selectable Range or Selections Default Value Setting
Load display data > Kind CF/USB CF
Load event data > Kind CF/USB CF
Load settings > Kind CF/USB CF
Save settings > Kind CF/USB CF
Save settings > File name 32 characters or less —
File list/delete > Kind CF/USB CF
Format > Kind CF/USB CF
Format > Volume name 11 characters or less —
Menu customize
Setup Item Selectable Range or Selections Default Value Setting
Function menu Select/Hide/View/Transfer -
Display menu Separate/Select/Hide/View/Transfer -
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Setup Items and Default Values

Alarm
Setup Item Selectable Range or Selections Default Value Setting
Basic setting
Reflash On/Off Off
Rate of change > Decrease 1to 32 1
Rate of change > Increase 1to0 32 1
Indicator Hold/Nonhold Nonhold
Switch, Relay
Internal Switch > AND None/S01/S01-S02/.../S01-S29/S01-S30 None
Relay > AND None/101/101-102/.../101-135/101-136 None
Relay > Action Energize/De_energ Energize
Relay > Hold Hold/Nonehold Nonhold
Relay > Relay Action on ACK* Normal/Reset Normal
Hysteresis
Meas CH > High/Low 0.0t0 5.0 0.5
Meas CH > Delta High/Low 0.0t0 5.0 0.0
Math CH > High/Low 0.0t0 5.0 0.0
Ext. CH > High/Low 0.0 to 5.0 0.0
* Afunction available on DXs with release number 2 or later.
A/D, Memory
Setup Item Selectable Range or Selections Default Value Setting
Scan interval > Scan mode Normal/Fast Normal
Normal > Scan interval 125ms/250ms(DX2004, DX2008) 125ms
1s/2s/5s(DX2010, DX2020, DX2030, 1s
DX2040, DX2048)
Normal > A/D integrate Auto/50Hz/60Hz/100ms Auto
Fast > Scan interval 25ms (DX2004, DX2008) 25ms
125ms (DX2010, DX2020, DX2030, DX2040, 125ms
DX2048)
Fast > A/D integrate 600Hz 600Hz
Memory > Data kind Display/E+D/Event Display
Burnout, RJC
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number -
Burnout set > Mode Off/Up/Down Off
RJC > Mode Internal/External Internal
RJC > Volt —20000 to 20000pV 0
Environment > Operating environment
Setup Item Selectable Range or Selections Default Value Setting
Tag/Channel Tag/Channel Tag
Language English/Japanese/German/French/Chinese English
Remote Controller ID Off/0/1/.../30/31 Off
Temperature C/F C
Environment > View, Message, Input, Alarm
Setup Item Selectable Range or Selections Default Value Setting

View > Trend type

T-Y/Circular

TY

View > Partial On/Off Off

View > Trend rate switching On/Off Off
Message > Write group Common/Separate Common
Message > Power-fail message On/Off Off
Message > Change message On/Off Off

Input > Value on over-range Free/Over Over
Alarm > No logging On/Off Off
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Setup Items and Default Values

Environment > Security, Media save, Batch

Setup Item Selectable Range or Selections Default Value Setting
Security > Key Off/Login/Keylock Off
Security > Communication Off/Login Off
Save > Auto save On/Off On
Save > Media FIFO* On/Off Off
Batch > On/Off On/Off Off
Batch > Lot-No. digit Off/4/6/8 6

Batch > Auto increment On/Off On

* A function available on DXs with release number 2 or later.

Environment > Service port

Setup Item Selectable Range or Selections Default Value Setting
FTP 1 to 65535 21

HTTP 1 to 65535 80
SNTP 1 to 65535 123
Modbus 1 to 65535 502
Environment > Math, Report

Setup Item Selectable Range or Selections Default Value Setting
Math > Value on Error +Over/-Over +Over
Math > Value on Overflow > SUM, AVE Error/Skip/Limit Skip
Math > Value on Overflow > MAX, MIN, P-P Over/Skip Over
Report > Report select > 1 Max/Min/Ave/Sum/Inst Ave
Report > Report select > 2 Off/Max/Min/Ave/Sum/Inst Max
Report > Report select > 3 Off/Max/Min/Ave/Sum/Inst Min
Report > Report select > 4 Off/Max/Min/Ave/Sum/Inst Sum
Report > File type Separate/Combine Separate
Keylock

Setup Item Selectable Range or Selections Default Value Setting
Password 8 characters or less —

Key action > START Free/Lock Free
Key action > STOP Free/Lock Free
Key action > MENU Free/Lock Free
Key action > USER Free/Lock Free
Key action > DISP/ENTER Free/Lock Free
Key action > FAVORITE Free/Lock Free
Media/USB > External media Free/Lock Free
Action of Function > AlarmACK Free/Lock Free
Action of Function > Message/Batch Free/Lock Free
Action of Function > Math Free/Lock Free
Action of Function > Data save Free/Lock Free
Action of Function > E-mail/FTP Free/Lock Free
Action of Function > Time set Free/Lock Free
Action of Function > Display Function Free/Lock Free
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Setup Items and Default Values

Login
Setup Item Selectable Range or Selections Default Value  Setting
User basic settings > Auto logout Off/1min/2min/5min/10min Off
User basic settings > Operation without Login ~ Off/Display Off
Admin settings > Admin number 1/2/3/4/5 1
Admin settings > Mode Off/Key/Comm/Web/Key+Comm Off
Admin settings > User name 20 characters or less Admin1 etc.
Admin settings > Password 8 characters or less 2?27?7°?°7?7?
User settings > User number 1/2/3/...129/30 1
User settings > Mode Off/Key/Comm/Web/Key+Comm Off
User settings > User name 20 characters or less User1 etc.
User settings > Password 8 characters or less 20°°°7°7?
User settings > Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off
Authority of user
Authority of user 1/2/3/415/6/7/8/9/10 1
Key action > START Free/Lock Free
Key action > STOP Free/Lock Free
Key action > MENU Free/Lock Free
Key action > USER Free/Lock Free
Key action > DISP/ENTER Free/Lock Free
Key action > FAVORITE Free/Lock Free
Media/USB > External media Free/Lock Free
Action of Function > AlarmACK Free/Lock Free
Action of Function > Message/Batch Free/Lock Free
Action of Function > Math Free/Lock Free
Action of Function > Data save Free/Lock Free
Action of Function > E-mail/FTP Free/Lock Free
Action of Function > Time set Free/Lock Free
Action of Function > Display Function Free/Lock Free
Report
Setup Item Selectable Range or Selections Default Value Setting
Basic settings > Report kind Off/Hour/Day/Hour+Day/Day+Week/Day+Month  Off
Basic settings > Date 1to 28 1
Basic settings > Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN
Basic settings > Time (hour) 0to 23 0:00
Report settings > Report channel number R01/R02/R03/.../R59/R60 RO1
Report settings > On/Off On/Off Depends on
the model
Report settings > Channel Channel number 1 etc.
Report settings > Sum scale Off, /s, /Imin, /h, /day Is
Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time settings > Time zone (HHMM) —1300 to 1300 900
Time settings > Time deviation limit Off/10s/20s/30s/1min/2min/3min/4min/5min 30s
Time settings > Date format Y/M/D, M/D/Y, DIM/Y, D.M.Y Y/M/D
Load settings, Initialize
Setup Item Selectable Range or Selections Default Value  Setting =%
Load settings > Kind CF/USB CF g;, _g
Initialize > Kind Clear 1/Clear 2/Clear 3 Clear 3 € =
Media eject CF/USB - < §
c
%2
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Setup Items and Default Values

Communication (Ethernet) > IP-address

Setup Item Selectable Range or Selections Default Value Setting
DHCP Use/Not Not
DNS accession Use/Not Use
Host-name register Use/Not Use
Fixed IP-address > |IP-address 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Subnet mask 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Default gateway 0.0.0.0 to 255.255.255.255 0.0.0.0
Communication (Ethernet) > Host settings
Setup Item Selectable Range or Selections Default Value Setting
Host name 64 characters or less -
Domain name 64 characters or less -
Communication (Ethernet) > DNS settings
Setup Item Selectable Range or Selections Default Value Setting
Server search order > Primary 0.0.0.0 to 255.255.255.255 0.0.0.0
Server search order > Secondary 0.0.0.0 to 255.255.255.255 0.0.0.0
Domain suffix search order > Primary 64 characters or less -
Domain suffix search order > Secondary 64 characters or less —
Communication (Ethernet) > Keep alive, Application time out
Setup Item Selectable Range or Selections Default Value Setting
Keep alive On/Off On
Application time out > On/Off On/Off Off
Application time out > Time 1 to 120 (min) 1
Communication(Ethernet) > Server
Setup Item Selectable Range or Selections Default Value Setting
FTP Use/Not Not
Web Use/Not Use*
SNTP Use/Not Not
Modbus Use/Not Not
* A value on DXs with release number 2 or later.
Communication (Ethernet) > Web page
Setup Item Selectable Range or Selections Default Value Setting
Page type Operator/Monitor Operator
Page type=Operator
Web page > On/Off On/Off Off
Web page > Access control Off/Admin Off
Web page > Command Use/Not Not
Page type=Monitor
Web page > On/Off On/Off Off
Web page > Access control Off/Admin/User Off
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Setup Items and Default Values

Communication (Ethernet) > E-Mail

Setup Item

Selectable Range or Selections

Default Value Setting

Basic settings
SMTP server name

64 characters or less

Port number 0 to 65535 25
Recipient 1 150 characters or less -
Recipient 2 150 characters or less -
Sender 64 characters or less —
Alarm settings
E-Mail Recipients > Recipient 1 On/Off Off
E-Mail Recipients > Recipient 2 On/Off Off
Active Alarms > Alarm 1 On/Off Off
Active Alarms > Alarm 2 On/Off Off
Active Alarms > Alarm 3 On/Off Off
Active Alarms > Alarm 4 On/Off Off
E-Mail Contents > Include INST On/Off Off
E-Mail Contents > Include source URL On/Off Off

E-Mail Contents > Subject
E-Mail Contents > Header 1
E-Mail Contents > Header 2

32 characters or less
64 characters or less
64 characters or less

Alarm_summary

Scheduled settings
E-Mail Recipients and Transmission time
>Recipient 1
E-Mail Recipients and Transmission time
> Interval
E-Mail Recipients and Transmission time
> Ref.time
E-Mail Recipients and Transmission time
> Recipient 2
E-Mail Recipients and Transmission time
> Interval
E-Mail Recipients and Transmission time
> Ref.time
E-Mail Contents > Include INST
E-Mail Contents > Include source URL
E-Mail Contents > Subject
E-Mail Contents > Header 1
E-Mail Contents > Header 2

On/Off

1h/2h/3h/4h/6h/8h/12h/24h

00:00 to 23:59

On/Off

1h/2h/3h/4h/6h/8h/12h/24h

00:00 to 23:59

On/Off

On/Off

32 characters or less

64 characters or less
64 characters or less

Off
24h
00:00
Off
24h
00:00

Off
Off
Periodic_data

System settings
E-Mail Recipients > Recipient 1
E-Mail Recipients > Recipient 2
E-Mail Contents > Include source URL
E-Mail Contents > Subject
E-Mail Contents > Header 1
E-Mail Contents > Header 2

On/Off
On/Off
On/Off
32 characters or less
64 characters or less
64 characters or less

Off
Off
Off
System_warning

Report settings
E-Mail Recipients > Recipient 1
E-Mail Recipients > Recipient 2
E-Mail Contents > Include source URL
E-Mail Contents > Subject
E-Mail Contents > Header 1
E-Mail Contents > Header 2

On/Off
On/Off
On/Off
32 characters or less
64 characters or less
64 characters or less

Off
Off
Off
Report_data
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Setup Items and Default Values

Communication (Ethernet) > FTP client

Setup Item Selectable Range or Selections Default Value Setting
FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
FTP transfer file > Snapshot On/Off Off
FTP connection Primary/Secondary Primary
FTP server name 64 characters or less -
Port number 0 to 65535 21
Login name 32 characters or less -
Password 32 characters or less -
Account 32 characters or less -
PASV mode On/Off Off
Initial path 64 characters or less —
Communication (Ethernet) > SNTP client
Setup Item Selectable Range or Selections Default Value Setting

SNTP client > Use/Not

SNTP client > Server name

SNTP client > Port number

SNTP client > Access interval

SNTP client > Access reference time
SNTP client > Access timeout

SNTP client > Time adjust on Start action

Use/Not

64 characters or less
0 to 65535
Off/1h/8h/12h/24h
00:00 to 23:59
10s/30s/90s

On/Off

Not
123
8h
00:00
30s
Off

Communication (Ethernet) > Modbus client

Setup Item Selectable Range or Selections Default Value Setting
Basic settings > Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Basic settings > Retry interval Off/10s/20s/30s/1min/2min/5min/10min/ 2min
20min/30min/1h
Server number 1-8/9-16 1-8
Modbus server settings > Port 0 to 65535 502
Modbus server settings > Modbus server name 64 characters or less -
Modbus server settings > Unit Auto/Fixed Auto
Modbus server settings > No. 0 to 255 1
Client command number 1-8/9-16 1-8
Command settings Off/R/R-M/W/W-M Off
Command settings > Client settings > First Depends on the command type. -
Command settings > Client settings > Last Depends on the command type. -
Command settings > Server settings > Server 1/2/3/...115/16 1
Command settings > Server settings > Registers  Numerical value 30001
Command settings > Server settings > Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT_L
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Setup Items and Default Values

Communication (Serial)

Setup Item

Selectable Range or Selections

Default Value Setting

Basic settings > Baud rate

1200/2400/4800/9600/19200/38400

9600

Basic settings > Data length 7/8 8
Basic settings > Parity Odd/Even/None Even
Basic settings > Handshaking Off:Off/ XON:XON/XON:RS/CS:RS Off:Off
Basic settings > Address 1to 99 1
Basic settings > Protocol Normal/Modbus/Modbus-M Normal
Modbus master > Basic settings > Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Modbus master > Basic settings > Timeout 125ms/250ms/500ms/1s/2s/5s/10s/1min 1s
Modbus master > Basic settings > Retrials Off/1/2/3/14/5/10/20 1
Modbus master > Basic settings > Off/5ms/10ms/15ms/45ms/100ms Off
Inter-block delay

Modbus master > Basic settings > Off/1min/2min/5min/10min/20min/30min/1h 2min
Auto recovery

Master command number 1-8/9-16 1-8
Command settings Off/R/R-M/W/W-M Off
Command settings > Master > First Depends on the command type. -
Command settings > Master > Last Depends on the command type. -
Command settings > Slave > Address 1to 247 1
Command settings > Slave > Registers Numerical value 30001
Command settings > Slave > Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT L

Status relay

Setup Item

Selectable Range or Selections

Default Value Setting

Memory/Media status On/Off Off
Measurement error On/Off Off
Communication error On/Off Off
Memory stop On/Off Off

End

Setup Item

Selectable Range or Selections

Default Value Setting

Do you want to store and
make the new settings take effect?

Yes/No/Cancel
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